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Chapter 1

Introduction

This document describes how to install and configure the Java-enabled e*Way 
Intelligent Adapter for DB2 Universal Database.

This Chapter Includes:

! “Overview” on page 10

! “Operational Overview” on page 11

! “Supported Operating Systems” on page 11

1.1 Overview
The DB2 Universal Database e*Way enables the e*Gate system to exchange data with 
external DB2 databases. This document describes how to install and configure the Java-
enabled version of the DB2 Universal Database e*Way.

The DB2 Universal Database e*Way uses the Java library to issue SQL statements to 
interact with DB2 databases.

1.1.1 Intended Reader
The reader of this guide is presumed to be a developer or system administrator with 
responsibility for maintaining the e*Gate system; to have expert-level knowledge of 
Windows NT (or Windows 2000) and UNIX operations and administration; to be 
thoroughly familiar with DB2 and SQL functions; and to be thoroughly familiar with 
Windows-style GUI operations. 

1.1.2 Components
The following components comprise the Java-enabled version of the DB2 Universal 
Database e*Way:

! e*Way Connections: Provide access to the information necessary for connecting to a 
specified external system.

! stcjdbcx.jar: Contains the logic required by the e*Way to interact with the external 
databases.

A complete list of installed files appears in Table 1 on page 16.
e*Way Intelligent Adapter for
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1.2 Operational Overview
The Java-enabled DB2 Universal Database e*Way uses Java Collaborations to interact 
with one or more external databases. By using the Java Collaboration Service it is 
possible for e*Gate components—such as e*Way Intelligent Adapters (e*Ways) and 
Business Object Brokers (BOBs)—to connect to external databases and execute business 
rules written entirely in Java.

An e*Gate component is defined as Java-enabled based on the selection of the Java 
Collaboration Service in the Collaboration Rule setup. For more information on the Java 
Collaboration Service, see “The Java Collaboration Service” on page 47.

1.3 Supported Operating Systems
Although the DB2 Universal Database e*Way components run on the platforms listed 
below, the Java-enabled ETD Editor and Collaboration Editor require the Windows NT 
operating system or the Windows 2000 operating system.

The DB2 Universal Database e*Way is available on the following operating systems:

! Windows 2000, Windows 2000 SP1, and Windows 2000 SP2

! Windows NT 4.0 SP6a

! Solaris 2.6, 7, and 8

! AIX 4.3.3

! HP-UX 11.0 and HP-UX 11i

! OS/390 V2R10

1.4 System Requirements
To use the DB2 Universal Database e*Way, you need the following:

! An e*Gate Participating Host, version 4.5.1 or later. For AIX operating systems, you 
need an e*Gate Participating Host, version 4.5.1. or later.

! A TCP/IP network connection.

The client components of the databases with which the e*Way interfaces have their own 
requirements; see that system’s documentation for more details. 

1.4.1 Host System Requirements
The external system requirements are different for a GUI host machine—specifically a 
machine running the ETD Editor and the Java Collaboration Editor GUIs—versus a 
participating host which is used solely to run the e*Gate schema.
e*Way Intelligent Adapter for
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GUI Host Requirements Using Merant Drivers

To enable the GUI editors to communicate with the external system, the following items 
must be installed on any host machines running the GUI editors:

! Merant ODBC 4.0 driver included on the driver installation cd.

If the GUI host machine will also be executing the DB2 Universal Database e*Way, the 
host machine must also meet the “Participating Host Requirements” on page 12.

GUI Host Requirements Using IBM Drivers for DB2

If you have chosen not to use the Merant ODBC drivers, you will need to assure you 
have the following components installed and configured appropriately.

To enable the GUI editors to communicate with the external system, the following items 
must be installed on any host machines running the GUI editors:

! Universal Database (UDB) version 7.2 client library

! The UDB client library must be installed on Windows NT/2000 to utilize the build 
tool.

! Java JDK 1.3. The JDK can be installed during the e*Gate GUI installation process if 
it hasn’t been installed already.

! Microsoft Data Access Components (MDAC) RTM version 2.6 or greater. This 
component is included in the e*Gate installation routine. If the GUI host machine 
will also be executing the UDB e*Way, the host machine must also meet the 
“Participating Host Requirements” on page 12.

Participating Host Requirements

The DB2 Universal Database e*Way requires that the following items be installed on the 
Participating Host:

! Merant JDBC 2.1 drivers. These drivers are located on the driver installation disk 
included with the e*Gate installation disks.

Participating Host Requirements Using IBM Drivers for DB2

If you have chosen not to use the Merant ODBC drivers, you will need to assure you 
have the following components installed and configured appropriately.

The UDB e*Way Installation program installs the Type 4 JDBC drivers required to 
connect to the external UDB database. These drives will be appropriate for most UDB 
implementations. However, for implementations using protocols other than Type 4, the 
appropriate client drivers must be installed.

A complete list of drivers from third party vendors can be found at:

http://industry.java.sun.com/products/jdbc/drivers

! The DB2 Universal Database client library. The client must be configured to 
communicate with the DB2 database.
e*Way Intelligent Adapter for
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! The most recent IBM DB2 software updates must be installed. These updates 
provide support for the latest Java functionality.

Note: If you have chosen to use the IBM drivers for DB2, please be aware that these drivers 
do not support ResultSets.

Host Requirements for an OS/390 Operating System

To use the DB2 Universal Database e*Way running on an OS/390 operating system, you 
must meet the requirments for the GUI Host and the Participating Host using the 
Merant DataDirect drivers. These drivers are located on the driver installation disk 
included with the e*Gate installation disks.

1.5 External System Requirements
The DB2 e*Way supports the following external systems:

! DB2 Universal Database (UDB) version 7.2

! DB2 Universal Database (UDB) version 6.1 when connecting to DB2 on an OS/390 
operating system. Additionally, for XA support, DB2 Connect version 7.2 and the 
configuration of SyncPoint Manager are required.
e*Way Intelligent Adapter for
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Installation

This chapter describes how to install the DB2 Universal Database e*Way.

This Chapter Includes:

! “Installing the DB2 Universal Database e*Way on Windows NT or 
Windows 2000” on page 14

! “Installing the DB2 Universal Database e*Way on UNIX” on page 15

! “Files/Directories Created by the Installation” on page 16

2.1 Installing the DB2 Universal Database e*Way on 
Windows NT or Windows 2000

2.1.1 Pre-installation
1 Quit all Windows-based programs before running the setup program, including 

any anti-virus applications.

2 You must have Administrator privileges to install this e*Way.

3 To use the DB2 e*Way, you must also setup your DB2 environment. This is required, 
because the e*Way connection point will look for the database name in the database 
directory of the DB2 client configuration on the system. 

2.1.2 Installation Procedure
To install the DB2 Universal Database e*Way on a Windows NT or Windows 2000 system

1 Log in as an Administrator on the workstation on which you want to install the 
e*Way.

2 Insert the e*Gate installation CD-ROM into the CD-ROM drive.

3 If the CD-ROM drive’s “Autorun” feature is enabled, the setup application should 
launch automatically; skip ahead to step 4. Otherwise, use Windows Explorer or the 
Control Panel’s Add/Remove Applications feature to launch the file setup.exe on 
the CD-ROM drive.
e*Way Intelligent Adapter for
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4 The InstallShield setup application will launch. Follow the on-screen instructions to 
install the e*Way.

Note: Be sure to install the e*Way files in the suggested “client” installation directory. The 
installation utility detects and suggests the appropriate installation directory. 
Unless you are directed to do so by SeeBeyond support personnel, do not 
change the suggested “installation directory” setting.

2.2 Installing the DB2 Universal Database e*Way on UNIX

2.2.1 Pre-installation
You do not require root privileges to install this e*Way. Log in under the user name that 
you wish to own the e*Way files. Be sure that this user has sufficient privilege to create 
files in the e*Gate directory tree.

To use the DB2 e*Way, you must also setup your DB2 environment. This is required, 
because the e*Way connection point will look for the database name in the database 
directory of the DB2 client configuration on the system. 

2.2.2 Installation Procedure
To install the DB2 Universal Database e*Way on a UNIX system

1 Log in on the workstation containing the CD-ROM drive, and insert the CD-ROM 
into the drive.

2 If necessary, mount the CD-ROM drive.

3 At the shell prompt, type 

cd /cdrom

4 Start the installation script by typing:

setup.sh

5 A menu of options will appear. Select the “install e*Way” option. Then, follow any 
additional on-screen directions.

Note: Be sure to install the e*Way files in the suggested “client” installation directory. The 
installation utility detects and suggests the appropriate installation directory. 
Unless you are directed to do so by SeeBeyond support personnel, do not 
change the suggested “installation directory” setting.
e*Way Intelligent Adapter for
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2.3 Files/Directories Created by the Installation
The DB2 Universal Database e*Way installation process will install the following files 
within the e*Gate directory tree. Files will be installed within the “egate\client” tree on 
the Participating Host and committed to the “default” schema on the Registry Host.

2.4 The db2cli.ini File
To use a Clob/Blob, you will need to set the LONGDATACOMPAT = 0 in the file 
db2cli.ini under the DB2 root directory. This will disable the LongVarChar, 
LongVarBinary, and LongVarGraphic. Refer to the IBM Installation and Configuration 
Supplement for more information.

2.5 The db2java.zip
The DB2 Universal Database e*Way uses the drivers contained in the db2java.zip file. 
To add the drivers, do the following:

Assure that the db2java.zip file from your DB2 Client software is installed into 
/Program Files/SQLLib/Java

From the e*Gate Enterprise Manager, click File on the tool bar. Click Commit to 
Sandbox... from the drop down menu. Browse to the /Program Files/SQLLib/Java 
folder and select the db2java.zip file. Click Open

From the e*Gate Collaboration, click Tools on the tool bar. Click Options from the drop 
down menu. Add the db2java.zip file.

Table 1   Files created by the installation

e*Gate Directory File(s)

stcewdb2.ctl

etd\db2 com_stc_jdbcx_db2cfg.java

etd\db2 com_stc_jdbcx_db2cfg.xsc

ThirdParty\merant\classes DGbase.jar

ThirdParty\merant\classes DGdb2.jar

ThirdParty\merant\classes DGutil.jar

ThirdParty\merant\classes spy.jar

server\registry\repository\configs\db2 DB2.def

server\registry\repository\default\etd\ db2.ctl

server\registry\repository\default\etd dbwizard.ctl
e*Way Intelligent Adapter for
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2.6 Installing the DB2 Universal Database e*Way on an 
OS/390

2.6.1 Installation Procedure
To install the DB2 Universal Database e*Way on an OS/390 system

To install DB2 Universal Database e*Way on an OS/390 system, please refer to the 
e*Gate Integrator Installation Guide.

2.6.2 Running an OS/390 Participating Host with a Registry on 
another Host

When running the Registry Host on another machine, do the following to assure 
communication between the Registry Host and the Participating Host:

1 Run JDBC Test. See JDBC Test on page 23

2 From the Unix System Services, create a working directory.

3 From a command prompt shell to the newly created working directory.

4 FTP the following files from the Registry Host to the newly created working 
directory:

A The following file is in ASCII mode:

egate/server/registry/repository/default/ThirdParty/merant/db2bind/db
2bind.sh

These files are in Binary mode and copied to

egate/server/registry/repsitory/default/ThirdParty/:

merant/db2bind/db2bind.class

sun/classes/jdbc2_0-stcdext.jar

classes/DGbase.jar

classes/DGdb2.jar

classes/DGutil.jar

classes/sljc_brand.jar

classes/sljcx.jar

classes/spy.jar

5 Customize the file:

egate/server/registry/repository/default/ThirdParty/merant/db2bind/db
2bind.sh

by un commenting the following:
e*Way Intelligent Adapter for
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# export CLASSPATH=.:$PWD/jdbc2_0-
stdext.jar:$PWD/spy.jar:$PWD/DGbase.jar:$PWD/DGdb2.jar:$PWD/DGutil.ja
r

For example:

export CLASSPATH=.:$PWD/jdbc2_0-
stdext.jar:$PWD/spy.jar:$PWD/DGbase.jar:$PWD/DGdb2.jar:$PWD/DGutil.ja
r

Once you have completed the un commenting of the db2bind.sh script, you will need to 
customize the script by doing the following:

java db2bind USERID PASSWORD OS390r29.STC.COM S39LOC 446 E390COL 
E390PAC

6 Issue the chmod command to assure the db2bind.sh script is executable.

chmod +x db2bind.sh

7 Run the db2bind.sh script to re-bind the DB2 Collections and Package for the 
OS/390. See OS/390 Binding on page 27

USERID DB2Userid that has Bind Authority

PASSWORD Password for the DB2 Userid

OS390R290.stc.com Host name that DB2 is currently installed on

S390LOC DB2 DDCS/DRDA Location Name

446 DB2 DDCS/DRDA Port Name

E390COL DB2 Collection name (must not exceed 12 characters)

E390PAC DB2 Package name (must not exceed 7 characters)
e*Way Intelligent Adapter for
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Connectivity

Before you can configure your DB2 e*Way, you will need to test the connectivity. 
Follow the instructions provided to assure connectivity.

3.1 Registering the DataSource
To register your datasource, do the following:

1 Install the Merant 4.0 ODBC drivers. To do this, follow the installation instructions 
provided with the drivers.

2 On the task bar, click the Start button, and then click Control Panel.

3 Click Administrative Tools.

4 Click Data Sources (ODBC).

5 In the ODBC Data Source Administrator window, click the User DSN tab.

6 Click Add.

7 Select Merant 4.0 32BIT DB2 Wire Protocol and click Finish.

8 In the ODBC DB2 Wire Protocol and Driver Setup window, select the General tab. 
Enter the appropriate system information for your DB2 installation. See Figure 1.

Figure 1   ODBC DB2 Wire Protocol Driver Setup General Tab
e*Way Intelligent Adapter for
DB2 Universal Database User’s Guide 19 SeeBeyond Proprietary and Confidential



Chapter 3 Section 3.1
Connectivity Registering the DataSource
9 Click on the Bind tab. See Figure 2.

Figure 2   ODBC DB2 Wire Protocol Driver Setup Bind Tab

10 Enter all the information required to make a connection to your database. Once 
completed, test the connection by clicking the Test Connection button.

11 Verify that the information in the Logon to DB2 Wire Protocol window is correct. 
Click the OK button. See Figure 3.

Figure 3   Logon to DB2 Wire Protocol

12 If the connection was successful, you will see Connection Established! in the Test 
Connect window. Click OK. See Figure 4.

Figure 4   Test Connect
e*Way Intelligent Adapter for
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3.2 ODBC Test
ODBC Test is a utility available from Microsoft. To use this utility, you will need to 
download it from www.microsoft.com.

1 Download ODBC Test and follow the online instructions provided by Microsoft to 
install this utility.

Once installed do the following:

2 In the ODBC Test (ANSI) window, click the Handshake button on the toolbar to 
open the connection. See Figure 5.

Figure 5   ODBC Test - Handshake

3 In the Data Source dialog box, select the ODBC data source. Enter your User ID and 
Password. See Figure 6.

Figure 6   Full Connect

4 Click OK.

5 Once a connection has been established, the SeeBeyond ODBC driver must be 
unlocked for use with ODBC Test by setting two attributes. From the Attr menu, 
e*Way Intelligent Adapter for
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select SQLSetConnectionOption. Enter the following values. These values are 
case-sensitive and must be entered exactly as shown:

fOption: 1041, vParam: IVdg.LIC

fOption: 1042, vParam: STCDART2UI1DATAGATEQQQQQ

6 Click OK. See Figure 7.

Figure 7   ODBC Test (ANSI) - Connection Established

7 Enter the following statement in the Connection dialog box. See Figure 8.

select * from sysibm.systables

Figure 8   ODBC Test (ANSI) - Select Statement

8 On the toolbar, click the Execute button.

9 If the connection was successful, you will see the SQLExecDirect return statement 
in the Connection dialog box. See Figure 9
e*Way Intelligent Adapter for
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Figure 9   ODBC Test (ANSI) - Connection Successful

10 To view the data returned, click the Get Data button. The data returned by the 
query will display in the Connection dialog box. See Figure 10.

Figure 10   ODBC Test (ANSI) - Get Data

3.3 JDBC Test
JDBC Test is a utility provided by Merant for creating the packages used by JDBC and 
to test connectivity.

1 Run JDBC Test from a command line by typing the following:

From Windows

c:\eGate\Server\registry\repository\default\ThirdParty\
merant\jdbctest\jdbctest.bat

From UNIX

c:/eGate/Server/registry/repository/default/ThirdParty/
e*Way Intelligent Adapter for
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merant/jdbctest/jdbctest.sh

2 On the Connection menu, click Connect to DB.

Figure 11   Select a Database

3 For DB2 on Windows or UNIX, select the first line.

4 For DB2 on a mainframe system e.g. OS/390, select the second line.

5 Enter the information for each of the parameters that corresponds to the DB2 
database you are connecting to at the Database: prompt.

Note: If you are connecting to a database for the first time using JDBC, you must first 
create the necessary packages to assure connectivity. You must have package 
creation privileges on the server.

6 To create the packages, add the following two parameters to the connection string:

Note: If creating the package for the first time, replacePackge=TRUE should be excludedI

createDefaultPackage=TRUE;replacePackage=TRUE

For example:

jdbc:SeeBeyond:db2://os390r29.stc.com:446;locationName=S390LOC;
collectionId=JDBCPKG;packageName=JDBCPKG;embedded=true;
createDefaultPackage=TRUE;replacePackage=TRUE

7 Enter a User Name: and Password:

8 Click Connect.
e*Way Intelligent Adapter for
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Figure 12   Connection 1 - Connection Established

9 On the Connection menu, click Create Statement.

10 On the Statement menu, click Execute Stmt Query.

11 Enter the following SQL statement. See Figure 13:

select*from sysibm.systables

Figure 13   Execute SQL Query

12 Click Submit.
e*Way Intelligent Adapter for
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Figure 14   Connection 1 - Connection Succeeded

13 On the Results menu, click Show All Results to see the results of the query. See 
Figure 15.
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Figure 15   Connection 1 - Results

3.3.1 OS/390 Binding
If you are running the DB2 e*Way on an OS/390 operating system, you will need to re-
bind the Collections and Package that you just created using jdbctest. To re-bind the 
Collections and Package, you will need to log into your OS/390 host system and run 
the db2bind script that is located in the egate/client/ThirdParty/db2bind directory. 
You will need to edit the USERID and PASSWORD to read as follows prior to running 
the script:

USERID PASSWORD OS390R29.stc.com S390LOC 446 E390COL E390PAC
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e*Way Connection Configuration

This chapter describes how to configure the DB2 Universal Database e*Way 
Connections.

This Chapter Includes:

! “Create e*Way Connections” on page 28

! “DataSource Settings” on page 29

! “Connector Settings” on page 31

! “Configuration Considerations for Non-OS/390 Operating Systems” on page 35

! “Configuring your e*Way to Connect to an External OS/390 System” on page 35

4.1 Create e*Way Connections
The e*Way Connections are created and configured in the Enterprise Manager.

To create and configure the e*Way Connections

1 In the Enterprise Manager’s Component editor, select the e*Way Connections 
folder.

Figure 16   The e*Way Connections Folder

2 On the Palette, click the New e*Way Connection button .

3 The New e*Way Connection Configuration dialog box opens. Enter a name for the 
e*Way Connection and click OK.
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4 Double-click the new e*Way Connection to open the e*Way Connection Properties 
dialog box. See Figure 17 on page 29.

Figure 17   e*Way Connection Properties Dialog Box

5 In the e*Way Connection Type list, click DB2.

6 In the Event Type “get” interval box, enter an interval.

7 Click New to create a new e*Way Connection Configuration File.

The e*Way Connection Configuration File Editor will appear.

The e*Way Connection configuration file parameters are organized into the following 
sections:

! DataSource Settings

! connector

4.1.1 DataSource Settings
The DataSource settings define the parameters used to interact with the external 
database.

class

Description

Description

Specifies the Java class in the JDBC driver that is used to implement the 
ConnectionPoolDataSource interface.
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Required Values

A valid class name.

The default is com.SeeBeyond.jdbcx.db2.DB2DataSource. 

CollectionID

Description

The collection or group of packages to which a package is bound.

Required Values

Any valid string.

DatabaseName

Description

Specifies the name or alias of the database instance. The alias must match the database 
alias in the DB2 client’s database directory

Required Values

Any valid string.

LocationName

Description

The name of the DB2 location that you want to access. This is used with OS/390.

Required Values

Any valid string.

PackageName

Description

Specifies the name, 7 character limit, of the package that the drive uses to process static 
and dynamic SQL.

Required Values

Any valid string.

user name

Description

Specifies the user name the e*Way uses to connect to the database.

Required Values

Any valid string.
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password

Description

Specifies the password used to access the database.

Required Values

Any valid string.

PortNumber

Description

The TCP port number. PortNumber is used for DataSource connections only.

Required Values

Any valid string.

ServerName

Description

The IP address used for DataSource connections only.

Required Values

Any valid string.

timeout

Description

Specifies the login timeout in seconds.

Required Values

Any valid string. The default is 300 seconds.

4.1.2 Connector Settings
The Connector settings define the high-level characteristics of the e*Way Connection.

type

Description

Specifies the type of e*Way Connection. The current available type for JDBC 
connections is DB.

Required Values

The default is DB.
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class

Description

Specifies the JAVA class name of the JDBC connector object.

Required Values

The default is com.stc.eways.jdbcx.DbConnector.

transaction mode

This parameter specifies how a transaction should be handled.

! Automatic — e*Gate will take care of transaction control and users should not issue 
a commit or rollback. If you are using XA, you must set your connection 
establishment mode and your transaction mode both to Automatic

! Manual — You will manually take care of transaction control by issuing a commit 
or rollback.

Required Values

The required values are Automatic or Manual. The default is set to Automatic.

Mixing XA-Compliant and XA-Noncompliant e*Way Connections

A Collaboration can be XA-enabled if and only if all its sources and destinations are 
XA-compliant e*Way Connections. However, XA-related advantages can accrue to a 
Collaboration that uses one (and only one) e*Way Connection that is transactional but 
not XA-compliant—in other words, it connects to exactly one external system that 
supports commit/rollback (and is thus transactional) but does not support two-phase 
commit (and is thus not XA-compliant). Please see the e*Gate User’s Guide for usage and 
restrictions.

connection establishment mode

This parameter specifies how a connection with the database server is established and 
closed.

! Automatic indicates that the connection is automatically established when the 
collaboration is started and keeps the connection alive as needed. If you are using 
XA, you must set your connection establishment mode and your transaction mode 
both to Automatic.

! OnDemand indicates that the connection will be established on demand as 
business rules requiring a connection to the external system are performed. The 
connection will be closed after the methods are completed.

! Manual indicates that the user will explicitly call the connection connect and 
disconnect methods in their collaboration as business rules.

Required Values

The required values are Automatic, OnDemand or Manual. The default is set to 
Automatic.
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Note: If you are using Manual connection establishment mode, you must also use 
Manual transaction mode.

connection inactivity timeout

This value is used to specify the timeout for the Automatic connection establishment 
mode. If this is set to 0, the connection will not be brought down due to inactivity. The 
connection is always kept alive; if it goes down, re-establishing the connection will 
automatically be attempted. If a non-zero value is specified, the connection manager 
will try to monitor for inactivity so that the connection is brought down if the timeout 
specified is reached.

Required Values

Any valid string. 

connection verification interval

This value is used to specify the minimum period of time between checks for 
connection status to the database server. If the connection to the server is detected to be 
down during verification, your collaboration’s onDown method is called. If the 
connection comes up from a previous connection error, your collaboration’s onUp 
method is called.

Required Values

Any valid string.

4.2 Connection Manager
The Connection Manager allows you to define the connection functionality of your 
e*Way. You choose:

! When an e*Way connection is made.

! When to close the e*Way connection and disconnect.

! What the status of your e*Way connection is.

! When the connection fails, an OnConnectionDown method is called by the 
Collaboration

The Connection Manager was specifically designed to take full advantage of e*Gate 
4.5.2 and higher’s enhanced functionality. If you are running e*Gate 4.5.1 or earlier, this 
enhanced functionality is visible but will be ignored.

The Connection Manager is controlled in the e*Way configuration as described in 
Connector Settings on page 31. If you choose to manually control the e*Way 
connections, you may find the following chart helpful.
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Figure 18   e*Way Connection Control methods

Controlling When a Connection is Made

As a user, you can control when a connection is made. Using Connector Settings, you 
can choose to have e*Way connections controlled manually — through the 
Collaboration, or automatically — through the e*Way Connection Configuration. If you 
choose to control the connection you can specify the following:

! To connect when the Collaboration is loaded.

! To connect when the Collaboration is executed.

! To connect by using an additional connection method in the ETD.

! To connect by overriding any custom values you have assigned in the 
Collaboration.

! To connect by using the isConnected() method. The isConnected() method is called 
per connection if your ETD has multiple connections.

Controlling When a Connection is Disconnected

In addition to controlling when a connection is made, you can also manually or 
automatically control when an e*Way connection is terminated or disconnected. To 
control the disconnect you can specify:

! To disconnect at the end of a Collaboration.

! To disconnect at the end of the execution of the Collaborations Business Rules.

! To disconnect during a timeout.

! To disconnect after a method call.

Controlling the Connectivity Status

You can control how often the e*Way connection checks to verify if it is still alive and 
you can set how often it checks. See Connector Settings on page 31.

Automatic On-Demand Manual

onConnectionUp yes no no

onConnectionDown yes yes only if the 
connection 
attempt fails

no

Automatic Transaction (XA) yes no no

Manual Transaction (XA) yes no no

connect no no yes

isConnect no no yes

disconnect no no yes

timeout or connect yes yes no

verify connection interval yes no no
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4.3 Additional System Configurations
We recommend the following configuration considerations.

4.3.1 Configuration Considerations for Non-OS/390 Operating 
Systems

If you are using the DB2 Connect 7.2 client on a non-OS/390 operating system and you 
are running in XA mode, you will need to set your Add Database Wizard Security 
option to use the authentication value specified in your Server’s DBM configuration:

Figure 19   Add Database Wizard - Security for non-OS/390 Operating Systems

4.3.2 Configuring your e*Way to Connect to an External OS/390 
System

If you are connecting to an external OS/390 system, and you want to run XA, we 
recommend you try using the following configuration. However, every system is set up 
a bit differently and this configuration may not be best suited for your application. This 
is only a recommendation and does not suggest or imply that this is the only method or 
solution for running XA. For more information on how to best configure your 
particular system, please refer to IBM’s Red Book or contact your IBM System 
Administrator to discuss your specific needs.

For our sample implementation, the following steps must be followed in the order they 
appear. Skipping steps or proceeding in any other order then what is presented here 
will produce unacceptable results.

1 Install DB2 Universal Database Personal Edition, Version 7.2 for Windows. XA is 
only available using Version 7.2.
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2 From the Select Installation Type window, click Typical. Click Next.

Figure 20   DB2 - Select Installation Type

3 From the Create Database Wizard window, create a new database by entering a 
database, the default drive, alias, and any comments. Click Next.

Figure 21   DB2 - Create Database Wizard

4 Continue through the Installation process accepting all the default values for all 
remaining Wizard windows.

5 At a DB2 Command Line Processor window type:

db2 => update database manager configuration using tm_database TMB
6 Reboot your machine.

Installing DB2 Connect Personal Edition Version 7.2 for Windows

1 Place the DB2 Connect Personal Edition Version 7.2 installation disk in your CD-
ROM.
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2 From the Installation window, click Install.

Figure 22   DB2 Connect Personal Edition Version 7.2 for Windows - Install

3 If you encounter the following warning window, click Yes to continue.

Figure 23   Warning Window

4 From the Select Products window, select all products to install.
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Figure 24   DB2 - Select Products

5 From the Select Installation Type window, click Typical. Click Next.

Figure 25   DB2 - Select Installation Type

6 Choose the folder you wish to install DB2 from the Choose Destination Location 
window. Click Next.
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Figure 26   DB2 - Choose Destination Location

7 From the Start Copying Files window, click Next. DB2 will begin to copy files to 
location you specified.

8 Once the process has completed, reboot your machine.

Stopping the DB2 Related Services

1 On the desktop Start menu, click Settings, Control Panel.

2 On the Control Panel, click Administrative Tools.

3 On the Administrative Tools window, click Component Services.

4 From the Component Services Tree menu, click Services (Local).

5 From the list of Services, highlight the DB2 Security Server. Make sure the services 
have been stopped.

Figure 27   Windows Services Window - DB2 Security Server Stopped

6 From a command line prompt, execute the following:
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C:\Program Files\SQLLIB\java12>usejdbc2

7 The following output should display without any error messages:

UnZipSFX 5.31 of 31 May 1997, by Info-ZIP(Zip-Bugs@lists.wku.edu)
inflating: db2java.zip
inflating: db2jdbc.dll
inflating: db2ccs.exe
inflating: db2jd.exe
inflating: db2jds.exe

1 file(s) copied
1 file(s) copied
1 file(s) copied
1 file(s) copied
1 file(s) copied
1 file(s) copied

8 Restart the DB2 Security Server services.

Figure 28   Windows Services Window - DB2 Security Server Restarted

Creating a Connection to DB2 on the OS/390

1 From the IBM DB2 Client Configuration Assistant window, click Add.
e*Way Intelligent Adapter for
DB2 Universal Database User’s Guide 40 SeeBeyond Proprietary and Confidential



Chapter 4 Section 4.3
e*Way Connection Configuration Additional System Configurations
Figure 29   Client Configuration Assistant

2 From the Add Database Wizard window’s Source tab, click Manually configure a 
connection to a database. Click Next.

Figure 30   Add Database Wizard - Source Tab

3 From the Add Database Wizard window’s LDAP tab. Click Add database to your 
local machine. Click Next.

Figure 31   Add Database Wizard - LDAP Tab
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4 From the Add Database Wizard window’s Protocol tab. Click TCP/IP from the 
Protocol dialog box. Select The database physically resides on a host or AS/400 
system. Click Connect directly to the server. Click Next.

Figure 32   Add Database Wizard - Protocol Tab

5 From the Add Database Wizard window’s TCP/IP tab. Enter the Host name and 
Port number. Click Next.
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Figure 33   Add Database Wizard - TCP/IP Tab

6 From the Add Database Wizard window’s Database tab. Enter the name of your 
database, the database’s alias, and any comments. Click Next.

Figure 34   Add Database Wizard - Database Tab

7 From the Add Database Wizard window’s ODBC tab. Select Register this 
database for ODBC and click As a system data source. Click Next.
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Figure 35   Add Database Wizard - ODBC

8 From the Add Database Wizard window’s Node Options tab. Select Configure 
node options (Optional). In the Node options dialog box, enter your system name 
and the operating system. Click Next.

Figure 36   Add Database Wizard - Node Options

9 From the Add Database Wizard window’s Security Options tab. Select Configure 
security option (Optional). Click Host on AS/400 authentication (DCS). Click 
Finish.

Test the Connection

1 From the Confirmation - S390LOC window, click Test Connection. If a connection 
is not made, click Change to return to the wizard. If the connection was successful, 
click Close.
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For Pre-Exiting Connections

If you have pre-existing DB2 connections to an OS/390, you will need to reconfigure 
your connection paths to recognize this new configuration.
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Implementation

This chapter discusses how to implement the Java-enabled DB2 Universal Database 
e*Way in a production environment. Also included is a sample configuration. This 
chapter assumes that the DB2 Universal Database e*Way has been successfully 
installed.

This Chapter Includes:

! “Implementing Java-enabled Components” on page 46

! “The Java ETD Builder” on page 47

! “Sample Scenario—Polling from a DB2 Database” on page 65

5.1 Implementing Java-enabled Components
An e*Way or a BOB can be Java-enabled by selecting the Java Collaboration Service in 
the Collaboration Rules Properties. Either of these components can use e*Way 
Connections to exchange data with external systems.

Figure 37   The Java Collaboration Service

Java Collaboration 
Service
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5.1.1 The Java Collaboration Service
The Java Collaboration Service makes it possible to develop external Collaboration 
Rules that execute e*Gate business logic using Java code. Using the Java Collaboration 
Editor, you create Java classes that utilize the executeBusinessRules(), 
userTerminate(), and userInitialize() methods.

For more information on the Java Collaboration Service and sub collaborations, see the 
e*Gate Integrator Collaboration Services Reference Guide. For more information on the Java 
ETD Editor and the Java Collaboration Editor, see the e*Gate Integrator User’s Guide.

5.1.2 Java-enabled Components
To make an e*Gate component Java-enabled, the component’s Collaboration Rule must 
use the Java Collaboration Service. This requires all the intermediate components to 
also be configured correctly, since there is not a direct relationship between the e*Way 
or BOB and the Collaboration Service.

The e*Way or BOB requires one or more Collaborations. The Collaboration uses a 
Collaboration Rule. The Collaboration Rule uses a Collaboration Service. In order for 
the e*Way or BOB to be Java-enabled, the component’s Collaboration Rule must use the 
Java Collaboration Service.

5.2 The Java ETD Builder
The Java ETD Builder is used to generate a Java-enabled ETD. The ETD Builder 
connects to the external database and generates the ETD corresponding to the external 
tables and procedures.

5.2.1 The Parts of the ETD
There are four possible parts to the Java-enabled Event Type Definition as shown in 
Figure 38.

Figure 38   The Java-enabled ETD

! Element – This is the highest level in the ETD tree. The element is the basic 
container that holds the other parts of the ETD. The element can contain fields and 
methods.

! Field – Fields are used to represent data. A field can contain data in any of the 
following formats: string, boolean, int, double, or float.
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! Method – Method nodes represent actual Java methods.

! Parameter – Parameter nodes represent the Java method’s parameters.

5.2.2 Using the DBWizard ETD Builder
The DBWizard ETD Builder generates Java-enabled ETDs by connecting to external 
data sources and creating corresponding Event Type Definitions. The ETD Builder can 
create ETDs based on any combination of tables, stored procedures, or prepared SQL 
statements.

Field nodes are added to the ETD based on the tables in the external data source. Java 
method and parameter nodes are added to provide the appropriate JDBC functionality. 
For more information on the Java methods, refer to your JDBC developer’s reference.

To create a new ETD using the DBWizard

1 From the Options menu of the Enterprise Manager, choose Default Editor….

2 Verify that Java is selected, then click OK.

3 Click the ETD Editor button to launch the Java ETD Editor.

4 In the Java ETD Editor, click the New button to launch the New Event Type 
Definition Wizard.

5 In the New Event Type Definition Wizard, select the DBWizard and click OK to 
continue.

Figure 39   New Event Type Definition 

6 Enter the name of the new .xsc file you want to create or enter the name of the .xsc 
file you want to edit by browsing to its location.
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Figure 40   Database Wizard - Introduction

7 Select your Data Source: from the drop down list and enter your User Name: and 
Password:.

Figure 41   Database Wizard - DSN Selection

8 Select what type of database ETD you would like to generate. The data source you 
selected in the Database Wizard - DSN Selection window is the default. Note: Do 
not change this unless instructed to do so by SeeBeyond personnel.
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Figure 42   Database Wizard - ETD Type Selection

9 In the Database Wizard - Object Selection window, select any combination of 
Tables, Views, Procedures, or Prepared Statements you would like to include in 
your .xsc file. Click Next to continue.

Figure 43   Database Wizard - Object Selection

10 In the Database Wizard - Tables window, click Add Tables.
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Figure 44   Database Wizard - Tables

11 In the Add Tables window, type the exact name of the database table or use 
wildcard characters to return table names.

Figure 45   Add Tables

12 To see a list of valid wildcard characters, click the round ball with a question mark 
located in its center.

Figure 46   Wildcards

13 Select Include System Tables if you wish to include them and click Search. If your 
search was successful, you will see the results in the Results window. To select the 
name of the tables you wish to add to your .xsc, double click on the table name or 
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highlight the table names and click Add Tables. You may also use adjacent 
selections or nonadjacent selections to select multiple table names. When you have 
finished, click Close.

14 In the Database Wizard - Tables window, review the tables you have selected. If 
you would like to change any of the tables you have selected, click Change.

15 In the Columns Selection window, you can select or deselect your table choices. 
You can also change the data type for each table by highlighting the data type and 
selecting a different data type from the drop down list. Once you have completed 
your choices, click OK.

Figure 47   Columns Selection

16 In the Database Wizard - Tables window, review the tables you have selected. If 
you do not want to use fully-qualified table names in the generated Java code, click 
to clear the check box and click Next to continue.

17 If you selected Views on the Database Wizard - Object Selection window, you are 
presented with the Database Wizard - Views window. Follow steps 9 - 15 to select 
and add views to your .xsc. Views are read-only.
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Figure 48   Database Wizard - Views

18 If you selected Procedures on the Database Wizard - Object Selection window, you 
are presented with the Database Wizard - Procedures window. Follow steps 9 - 15 
to select and add Procedures to your .xsc. If you do not want to use fully-qualified 
procedure names in the generated Java code, click to clear the check box and click 
Next to continue.

Figure 49   Database Wizard - Procedures
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19 If you selected Prepared Statements on the Database Wizard - Object Selection 
window, you are presented with the Database Wizard - Prepared Statement 
window. To add Prepared Statements to your .xsc. complete the following steps:

A Click Add to add a new prepared statement

B Enter a prepared SQL statement.

C Enter the Prepared Statement Name to be used by the statement.

D Use the Open… or Save… buttons to open pre-existing statements or save the 
current one.

E Click OK to return to the Database Wizard - Prepared Statements window.

20 Repeat steps A–E to add additional prepared statements or click Next to continue.

Figure 50   Database Wizard - Prepared Statements

21 Enter the Java Class Name that will contain the selected tables and/or procedures 
and the Package Name of the generated classes.
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Figure 51   Database Wizard - Class and Package

22 View the summary of the database wizard information and click Finish to begin 
generating the ETD.

Figure 52   Database Wizard - Summary

5.2.3 The Generated ETDs
The DataBase Wizard ETD builder can create three editable Event Type Definitions 
(ETDs) and one non-editable Event Type Definition (ETD). These types of ETDs can 
also be combined with each other. The four types of ETDs are:

! The Table ETD – The table ETD contains fields for each of the columns in the 
selected table as well as the methods required to exchange data with the external 
data source. To edit this type of ETD, you will need to open the .xsc in the DataBase 
Wizard.
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! The View ETD - The view ETD contains selected columns from selected tables. 
View ETD’s are read-only.

! The Stored Procedure ETD – The stored procedure ETD contains fields which 
correspond to the input and output fields in the procedure. To edit this type of ETD, 
you will need to open the .xsc in the DataBase Wizard

! The Prepared Statement ETD – The prepared statement ETD contains a result set 
for the prepared statement. To edit this type of ETD, you will need to open the .xsc 
in the DataBase Wizard

5.2.4 Editing an Existing .XSC Using the Database Wizard
If you choose to edit an existing .xsc that you have created using the Database Wizard, 
do the following:

1 From the Options menu of the Enterprise Manager, choose Default Editor….

2 Verify that Java is selected, then click OK.

3 From the Tools menu, click ETD Editor...

4 From the ETD Tool menu click File and click New.

5 From the New Event Type Definition window, select DBWizard and click OK.

6 On the Database Wizard - Introduction window, select Modify an existing XSC 
file: and browse to the appropriate .xbs file that you would like to edit.

You are now able to edit your .xsc file.

Note: When you add a new element type to your existing .xsc, you must reselect any pre-
existing elements or you will loose them when the new .xsc is created.

If you attempt to edit an .xsc whose elements no longer exist in the database, you will see a 
warning and the element will be dropped from the ETD.

5.3 Using ETDs with Tables, Views, Stored Procedures, and 
Prepared Statements

The Insert, Delete, Update, and Execute Methods are common methods used within the 
Collaboration Editor. Though our sample schema doesn’t include these methods, we 
thought it would be helpful to show them to you.

5.3.1 The Table
A table ETD represents a database table. It consists of fields and methods. Fields 
correspond to the columns of a table while methods are the operations that you can 
apply to the ETD. This allows you to perform select, update, insert and delete SQL 
operations in a table.
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The select() Method

To preform a select operation on a table, add a new method in the Collaboration Editor 
by clicking on the method button. In the Method Properties box, define the method. 
Add a rule to the method by clicking on the rule{} button. The Rule Properties dialog 
box appears. Select the node and drag and drop it into the dialog box. This method 
takes an empty string or a WHERE clause. For example:

getDBEmp().getDB_EMPLOYEE().select("EMP_NO = 123");

The insert() Method

To preform a insert operation on a table, do the following:

1 From the Collaboration Editor, click the method button. Execute the select method 
with the right concurrency for example CONCUR_UPDATABLE and scroll 
sensitivity for example TYPE_SCROLL_INSENSITIVE, 
TYPE_SCROLL_SENSITIVE.

2 Move to the insert row by the moveToInsertRow method.

3 Set the fields of the table ETD

4 Insert the row by calling insertRow

This example inserts an employee record.

getDBEmp().getDB_EMPLOYEE(ResultSet.TYPE_SCROLL_SENSITIVE, 
ResultSet.CONCUR_UPDATABLE).select("");
getDBEmp().getDB_EMPLOYEE().moveToInsertRow();
getDBEmp().getDB_EMPLOYEE().setEMP_NO(123);
. . .
getDBEmp().getDB_EMPLOYEE().setRATE(123.45);
getDBEmp().getDB_EMPLOYEE().insertRow();
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Figure 53   Insert Method Business Rule

Figure 54   Insert Method Properties

The update() Method

To perform an update operation on a table, do the following:

1 Execute the select method with the right concurrency for example 
CONCUR_UPDATEABLE and scroll sensitivity for example 
TYPE_SCROLL_INSENSITIVE, TYPE_SCROLL_SENSITIVE.

2 Move to the row that you want to update.

3 Set the fields of the table ETD

4 Insert the row by calling insertRow.

In this example, we move to the third record and update the EMP_NO and RATE 
fields.

getDBEmp().getDB_EMPLOYEE(ResultSet.TYPE_SCROLL_SENSITIVE, 
ResultSet.CONCUR_UPDATABLE).select("");
getDBEmp().getDB_EMPLOYEE().absolute(3);
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getDBEmp().getDB_EMPLOYEE().setEMP_NO(123);
getDBEmp().getDB_EMPLOYEE().setRATE(123.45);
getDBEmp().getDB_EMPLOYEE().updateRow();

Figure 55   Update() Method Business Rule

The delete() Method

To perform a delete operation on a table do the following:

1 Execute the select method with the right concurrency for example 
CONCUR_UPDATEABLE and scroll sensitivity for example 
TYPE_SCROLL_INSENSITIVE, TYPE_SCROLL_SENSITIVE.

2 Move to the row that you want to delete.

3 Set the fields of the table ETD

4 Insert the row by calling insertRow.

In this example DELETE the first record of the result set.

getDBEmp().getDB_EMPLOYEE(ResultSet.TYPE_SCROLL_SENSITIVE, 
ResultSet.CONCUR_UPDATABLE).select("");
getDBEmp().getDB_EMPLOYEE().first();
getDBEmp().getDB_EMPLOYEE().deleteRow();

5.3.2 The View
Views are used to look at data from selected columns within selected tables. Views are 
read-only.

5.3.3 The Stored Procedure
A Stored Procedure ETD represents a database stored procedure. Fields correspond to 
the arguments of a stored procedure while methods are the operations that you can 
apply to the ETD. It allows you to execute a stored procedure. Remember that while in 
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the Collaboration Editor you can drag and drop nods from the ETD’s into the 
Collaboration Editor.

Collecting Data from Output Parameters

You can collect data within a Stored Procedure Result Set by using output parameters.

An example of how to execute a stored procedure using output parameters is:

create procedure LookupGlobal
( @inlocalID varchar, @outglobalProductID varchar output )
as
begin
select @outglobalProductID = globalProductID from SimpleLookup where 
localID = @inlocalID
end
go

In the following image, the ETD represents the Stored Procedure “LookUpGlobal” with 
two parameters, an inbound parameter (INLOCALID) and an outbound parameter 
(OUTGLOBALPRODUCTID). Representing these as nodes in an ETD allows you to 
drag values from other ETD’s to the input parameters, execute the call, and collect the 
output parameter data by dragging from it’s node to elsewhere.

Figure 56   Stored Procedure LookUpGlobal

Returning Result Sets from Sybase, DB2, and SQL Server

The following Result Set processing returns rows into the body of the Stored Procedure. 
Databases that allow this operation are Sybase, DB2, and SQL Server.
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A stored procedure in a database can perform update and select operations. The 
application checks what operation has been performed. The following methods allow 
you to collect this information:

getUpdateCount:

This method should be called only after a call to executeRetVal or getMoreResults, and 
should be called only once per result. An int greater than 0 represents the number of 
rows affected by an operation. A value of 0 means no rows were affected or the 
operation is a DDL command. -1 means the result is a result set or there are no more 
results.

getResultSet:

When the executeRetVal method has been used to execute the stored procedure. This 
method returns the current result set if there is one. Otherwise, it returns a null value 
which indicates the result is an update count or there are no more results.

getMoreResults:

Moves to the next result. This method returns true if it gets the next result set. It returns 
false if it is an update count or there are no more results.

This example prints out the update count and result sets that are returned from the 
stored procedures.

         int iRow;
         com.stc.eways.jdbcx.ResultSetAgent rs;
         getpoller().getMrsSp().executeRetVal();

         do
         {
            iRow = getpoller().getMrsSp().getUpdateCount();
            System.out.println("\n*********iRow = " + 
Integer.toString(iRow));

            if (iRow >= 0)
            {
               getblobout().setField1("Number of rows affected: " + 
Integer.toString(iRow));
               getblobout().send();
            }
            else
            {
               rs = getpoller().getMrsSp().getResultSet();
               while (rs.next())
               {
                  getblobout().setField1("Col5 = " + 
Integer.toString(rs.getInt(1)) + ", Col6 = " + 
Integer.toString(rs.getInt(2)) );
                  getblobout().send();
               }
            }
         }
         while (getpoller().getMrsSp().getMoreResults());

Use an outbound parameter to enrich another ETD.
e*Way Intelligent Adapter for
DB2 Universal Database User’s Guide 61 SeeBeyond Proprietary and Confidential



Chapter 5 Section 5.3
Implementation Using ETDs with Tables, Views, Stored Procedures, and Prepared Statements
5.3.4 Prepared Statement
To Create a prepared statement from the DataBase Wizard:

1 Select the Prepared Statement option in the DataBase Wizard and complete the 
following steps:

A Click Add to add a new prepared statement

B Enter a prepared SQL statement as shown. The question marks serve as place 
holders that are later defined as the parameters in Figure 58 on page 63

Figure 57   Add Prepared Statement

C Enter the Prepared Statement Name to be used by the statement.

D Use the Open… or Save… buttons to open pre-existing statements or create and 
save the current one.

2 Figure 58 on page 63 shows the statement along with a table of the parameters. You 
can give each parameter an appropriate name and data type. These parameters 
become nodes in the prepared statement ETD and fields within the generated Java 
object.
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Figure 58   Prepared Statement Summary and Parameter Modification

3 From the ETD Editor, save the Prepared Statement you just created.

Figure 59   TableJavaClass
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Figure 60   Collaboration Rule Editor

4 Map the fields you would like to populate the table with from the Source Events to 
the Destination Events.

5 Create your rules by dragging and dropping each node into the Rules window. This 
particular example shows the Age, Name and Department Number of three 
employees.

Figure 61   Collaboration Business Rules

6 Run the schema and verify the new content in Employee database.

5.3.5 Batch Operations
While the Java API used by SeeBeyond does not support traditional bulk insert or 
update operations, there is an equivalent feature that can achieve comparable results, 
with better performance. This is the “Add Batch” capability. The only modification 
required is to include the addBatch() method for each SQL operation and then the 
executeBatch() call to submit the batch to the database server. 

getDBEmp().getDB_EMPLOYEE().select("");
         while (getDBEmp().getDB_EMPLOYEE().next())
         {
            
getPSDBEmp().getDbEmployeeUpdate().setEmployeeNo(getDBEmp().getDB_EMP
LOYEE().getEMP_NO());
            getPSDBEmp().getDbEmployeeUpdate().setNewTime(ts);
            getPSDBEmp().getDbEmployeeUpdate().addBatch();
         }
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         getPSDBEmp().getDbEmployeeUpdate().executeBatch();

5.3.6 Database Configuration Node
The Database Configuration node allows you to manage the “transaction mode” 
through the Collaboration if you have set the mode to manual in the e*Way connection 
configuration. See “Connector Settings” on page 21.

5.4 Sample Scenario—Polling from a DB2 Database
This section describes how to use the Java-enabled DB2 Universal Database e*Way in a 
sample implementation. This sample schema demonstrates the polling of records from 
a DB2 database and converting the records into e*Gate Events.

Figure 62 shows a graphical overview of the sample schema.

Figure 62   The Database Select Scenario—Overview

1 The FileIn e*Way retrieves an Event (a text file) containing the database select 
criteria and publishes it to the Q1 IQ.

2 The DBselect e*Way retrieves the Generic Event (Blob) from the IQ. This triggers 
the rest of the Collaboration which has two parts.

3 The information in Blob is used to retrieve information from the database via the 
DB2_eWc e*Way Connection. This e*Way Connection contains information used by 
the Collaboration to connect to the DB2 database.

4 The information retrieved from the database is copied to the Generic Event (Blob) 
and published to the Q2 IQ.

5 The FileOut e*Way retrieves the Generic Event (Blob) from the Q2 IQ then writes it 
out to a text file on the local file system.

Overview of Steps

The sample implementation follows these general steps:

! “Create the Schema” on page 67

! “Add the Event Types and Event Type Definitions” on page 67

! “Create the Collaboration Rules and the Java Collaboration” on page 70
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! “Add and Configure the e*Ways” on page 74

! “Add and Configure the e*Way Connections” on page 76

! “Add the IQs” on page 77

! “Add and Configure the Collaborations” on page 77

! “Run the Schema” on page 79

Figure 63   Schema Configuration Steps

External Database Tables

The sample uses a simple external DB2 database with a table called DB_EMPLOYEE. 
The table contains the following columns:

Create Schema

Add Event Types and
ETDs

Create Collaboration
Rules & the Java Collab

Add and Configure
e*Ways

Add and Configure
e*Way Connections

Add IQs

Add and Configure
Collaborations

Run the Schema
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Table 2   The DB_EMPLOYEE Table

5.4.1 Create the Schema
The first step in the sample implementation is creating a new schema. After installing 
the DB2 Universal Database e*Way, do the following:

1 Start the e*Gate Enterprise Manager GUI.

2 Log in to the appropriate Registry Host.

3 From the list of schemas, click New to create a new schema.

4 For this sample implementation, enter the name DBSelect and click Open.

The Enterprise Manager starts and the newly created schema appears.

5.4.2 Add the Event Types and Event Type Definitions
Two Event Types and Event Type Definitions are used in this sample.

! DBEmployee – This Event Type represents the layout of the employee records in 
the DB_Employee table. The Event Type uses the DBEmployee.xsc Event Type 
Definition. The ETD will be generated by using the Java ETD Editor’s Database 
Wizard (DBWizard).

! GenericBlob – This Event Type is used to pass records with no specific format 
(blob). The Event Type uses the GenericBlob.xsc ETD. The ETD will be manually 
created as a fixed-length ETD.

To create the DBEmployee Event Type and ETD

1 From the Options menu of the Enterprise Manager, choose Default Editor….

2 Verify that Java is selected, then click OK.

3 In the Components pane of the Enterprise Manager, select the Event Types folder.

4 Click the New Event Type button to add a new Event Type.

5 Enter the name DBEmployee and click OK.

6 Double-click the new DBEmployee Event Type to display its properties.

7 Select your Data Source: from the drop down list and enter your User Name: and 
Password:.

8 From the File menu, choose New. The New Event Type Definition dialog box will 
appear.

Column Format Description

EMP_NO INTEGER The employee number.

LAST_NAME VARCHAR2 The employee’s last name.

FIRST_NAME VARCHAR2 The employee’s first name.

RATE FLOAT The employee’s pay rate.

LAST_DATE DATETIME The last transaction date for the employee.
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9 In the New Event Type Definition dialog box, select DBWizard and click OK.

10 Select Create a new .XSC file. Click Next to continue. See Figure 64.

Figure 64   Database Wizard Introduction

11 Enter the database DNS source and login information.

A Select the Data Source from the dropdown list of ODBC data sources.

B Enter the User Name and Password used to log into the database.

Click Next to continue. See Figure 65

Figure 65   Database Wizard - DSN Selection

12 The Database Wizard - ETD Type Selection window appears. The DNS source you 
selected on the previous window is the default selection for this window. Do not 
change this selection type unless instructed to do so by SeeBeyond support 
personal. Click Next to continue.
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13 This scenario uses a table rather than a procedure. Select Table and click Next to 
continue. 

14 From the Database Wizard - Tables window, click Add Tables... Enter the exact 
Table Name or enter any valid wildcards. From the drop down list select the 
appropriate database schema and click Search. The wizard connects to the data 
source and display a list of tables.

15 Select the table to be included in the ETD and click Next. 

16 The Java Class Name/ Package Name dialog box will appear. Enter the Group and 
Package information.

A Enter your database name as the Java Class Name.

B Enter DBEmployee for the Package Name and click Next to continue.

17 Click Finish to complete the Wizard. The Wizard will generate and display the 
ETD.

18 From the File menu, choose Save. 

19 Name the ETD DBEmployee.xsc and click OK.

20 From the File menu, choose Promote to Run Time and click OK when finished.

21 From the File menu, choose Close to exit the ETD Editor.

To create the GenericBlob Event Type and ETD

1 In the Components pane of the Enterprise Manger, select the Event Types folder.

2 Click the New Event Type button to add a new Event Type.

3 Enter the name GenericBlob and click OK.

4 Double-click the new GenericBlob Event Type to display its properties.

5 Click the New button to create a new Event Type Definition. The Java Event Type 
Definition Editor appears.

6 From the File menu, choose New. The New Event Type Definition dialog box 
appears.

7 In the New Event Type Definition dialog box, select Standard ETD and click OK.

8 Read the Introduction screen, then click Next to continue. The Package Name 
dialog box appears.

9 Enter GenericBlobPackage for the Package Name and click Next to continue.

10 Read the summary information and click Finish to generate the ETD.

11 In the Event Type Definition pane, right-click the root node, point to Add Field in 
the shortcut menu, and click As Child Node.

12 Enter the properties for the two nodes as shown in Table 3.
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Table 3   GenericBlob ETD Properties

Note: To use a Blob, you will need to set the LONGDATACOMPAT = 0 in the file 
db2cli.ini under the DB2 root directory. This will disable the LongVarChar, 
LongVarBinary, and LongVarGraphic. Refer to the IBM Installation and 
Configuration Supplement for more information.

13 From the File menu, choose Save.

14 Enter the name GenericBlob.xsc and click OK.

15 From the File menu, choose Promote to Run Time and click OK when finished.

16 From the File menu, choose Close to exit the ETD Editor.

17 In the Event Type properties dialog box, click OK to save and close the Event Type.

5.4.3 Create the Collaboration Rules and the Java Collaboration
The sample scenario uses two Collaboration Rules and one Java Collaboration:

! GenericPassThru – This Collaboration Rule is used to pass the GenericBlob Event 
Type through the schema without modifying the Event.

! DBSelect – This Collaboration Rule is used to convert the inbound Event’s selection 
criteria into a SQL statement, poll the external database, and return the matching 
records as an outbound Event.

! DBSelectCollab – This Java Collaboration contains the logic required to 
communicate with the external database.

To create the GenericPassThru Event Type

1 In the components pane of the Enterprise Manager, select the Collaboration Rules 
folder.

2 Click the New Collaboration Rules button to add a new Collaboration Rule.

3 Name the Collaboration Rule GenericPassThru and click OK.

4 Click the Properties button to display the Collaboration Rule’s properties.

5 Click the Subscriptions tab, select the GenericBlob Event Type, and click the right 
arrow.

6 Click the Publications tab, select the GenericBlob Event Type, and click the right 
arrow.

Node Property Value

Root Node Name GenericBlob

Structure fixed

Length 0

Child Node Name Data

Structure fixed

Length 0
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7 Click OK to save the Collaboration Rule.

To create the DBSelect Event Type

1 In the components pane of the Enterprise Manager, select the Collaboration Rules 
folder.

2 Click the New Collaboration Rules button to add a new Collaboration Rule.

3 Name the Collaboration Rule DBSelect and click OK.

4 Click the Properties button to display the Collaboration Rule’s properties.

5 In the Service list, click Java.

6 Click the Collaboration Mapping tab.

7 Add three instances as shown in Figure 66 below:

Figure 66   DBSelect Instances

8 Click Apply to save the current changes.

9 Click the General tab.

10 Click New to create the new Collaboration file.

The Java Collaboration Editor appears. Note that Source and Destination Events are 
already supplied based on the Collaboration Rule’s Collaboration Mapping (see 
Figure 66).

11 From the View menu, choose Display Code.

This displays the Java code associated with each of the Collaboration’s rules.

12 In the Business Rules pane, select the retBoolean rule and click the rule button to 
add a new rule.

13 In the Destination Events pane, expand the DBEmployee Event Type until the 
select method is visible.

14 Drag the select method into the Rule field of the Rule Properties pane. Click OK to 
close the dialog box without entering any criteria. (See Figure 67).
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Figure 67   Rule Properties

15 In the Source Events pane, expand the GenericBlobIn Event Type until the Data 
node is visible.

16 In the Rule Properties pane, position the cursor inside the parentheses of the select 
method. Then drag the Data node from the Source Events pane into the select 
method’s parentheses. (See Figure 68).

Figure 68   Rule Properties (Continued)

17 Select the newly edited rule in the Business Rules pane and click the while button 
to add a new while loop beneath the current rule.

18 Drag the next method from the Destination Events pane into the Condition field of 
the While Properties pane. (See Figure 69).

Figure 69   While Properties

19 Select the newly edited while loop in the Business Rules pane and click the rule 
button to add a new rule as a child to the while loop.

20 In the Destination Events pane, expand the GenericBlobOut Event Type until the 
Data node is visible.

21 Drag the Data node into the Rule field of the Rule Properties pane. (See Figure 70).
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Figure 70   Rule Properties

22 In the Rule Properties pane, position the cursor inside the parentheses of the 
setData() method. Then drag each of the five data nodes of DB_EMPLOYEE from 
the Source Events into the parentheses of the rule. (See Figure 71).

Figure 71   Rule Properties (Continued)

23 Edit the text of the condition to add a newline character and pipe (|) delimiters 
between each of the five data nodes. (See Figure 72).

Figure 72   Rule Properties (Continued)

24 Select the newly edited rule in the Business Rules pane and click the rule button to 
add a new rule inside the while loop.

25 Drag the root node of the GenericBlobOut Event into the rule field in the Rule 
Properties pane.

26 Edit the rule; add a send() method as shown in Figure 73.
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Figure 73   GenericBlobOut send()

27 From the File menu, choose Save to save the file.

28 From the File menu, choose Compile to compile the Collaboration.

View the Output pane to ensure that there were no compiler errors.

29 From the File menu, choose Close to close the Java Collaboration Editor and return 
to the Collaboration Rule.

Note that the Collaboration Rules and Initialization file fields have been 
completed by close the Java Collaboration Editor.

30 Click OK to save and close the DBSelect Collaboration Rule.

5.4.4 Add and Configure the e*Ways
The sample scenario uses three e*Ways:

! FileIn – This e*Way retrieves an Event (text file) containing the database select 
criteria and publishes it to the Q1 IQ.

! DBSelect – This e*Way retrieves the Generic Event (Blob) from the Q1 IQ. This 
triggers the e*Way to request information from the external database (via the e*Way 
Connection) and publishes the results to the Q2 IQ.

! FileOut – This e*Way retrieves the Generic Event (Blob) from the Q2 IQ then writes 
it out to a text file on the local file system.

To create the FileIn e*Way

1 In the Components pane of the Enterprise Manager, select the Control Broker and 
click the New e*Way button.

2 Enter FileIn for the component name and click OK.

3 Select the newly created e*Way and click the Properties button to display the 
e*Way’s properties.

4 Use the Find button to select stcewfile.exe as the executable file.

5 Click New to create a new configuration file.

6 Enter the parameters for the e*Way as shown in Table 4.
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Table 4   FileIn e*Way Parameters

7 Select Save from the File menu. Enter FileIn as the file name and click Save.

8 Select Promote to Run Time from the File menu. Click OK to close the e*Way 
configuration file editor.

9 In the Start Up tab of the e*Way properties, select the Start automatically check box.

10 Click OK to save the e*Way properties.

To create the DBSelect e*Way

1 In the Components pane of the Enterprise Manager, select the Control Broker and 
click the New e*Way button.

2 Enter DBSelect for the component name and click OK.

3 Select the newly created e*Way and click the Properties button to display the 
e*Way’s properties.

4 Use the Find button to select stceway.exe as the executable file.

5 Click New to create a new configuration file.

6 Enter the parameters for the e*Way as shown in Table 5.

Table 5   DBSelect e*Way Parameters

7 Select Save from the File menu. Enter DBSelect as the file name and click Save.

8 Select Promote to Run Time from the File menu. Click OK to close the 
configuration file editor.

9 In the Start Up tab of the Business Object Broker properties, select the Start 
automatically check box.

10 Click OK to save the e*Way’s properties.

Section Name Parameter Value

General Settings AllowIncoming YES

AllowOutgoing NO

PerformanceTesting default

Outbound (send) settings All default

Poller (inbound) settings PollDirectory c:\egate\data\dbSelect_In

All Others default

Performance Testing All default

Section Name Parameter Value

JVM Settings CLASS Prepend Specify the path to the 
db2java.zip file.

All others default
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To create the FileOut e*Way

1 In the Components pane of the Enterprise Manager, select the Control Broker and 
click the New e*Way button.

2 Enter FileOut for the component name and click OK.

3 Select the newly created e*Way and click the Properties button to display the 
e*Way’s properties.

4 Use the Find button to select stcewfile.exe as the executable file.

5 Click New to create a new configuration file.

6 Enter the parameters for the e*Way as shown in Table 6.

Table 6   FileOut e*Way Parameters

7 Select Save from the File menu. Enter FileOut as the file name and click Save.

8 Select Promote to Run Time from the File menu. Click OK to close the e*Way 
configuration file editor.

9 In the Start Up tab of the e*Way properties, select the Start automatically check box.

10 Click OK to save the e*Way properties.

5.4.5 Add and Configure the e*Way Connections
The sample scenario uses one e*Way Connection:

! DB2_eWc – This e*Way Connection connects the DBSelect component to the 
external database and returns the requested records to be published to the Q2 IQ.

To create the e*Way Connection

1 In the Components pane of the Enterprise Manager, select the e*Way Connections 
folder.

2 Click the New e*Way Connection button to add a new e*Way Connection.

3 Enter DB2_eWc for the component name and click OK.

4 Select the newly created e*Way Connection and click the Properties button to 
display the e*Way Connection’s properties.

5 Select DB2 from the e*Way Connection Type dropdown list.

Section Name Parameter Value

General Settings AllowIncoming NO

AllowOutgoing YES

PerformanceTesting default

Outbound (send) settings OutputDirectory c:\egate\data\dbSelect_Out

OutputFileName dbSelect%d.dat

Poller (inbound) settings All default

Performance Testing All default
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6 Click New to create a new configuration file.

7 Enter the parameters for the e*Way Connection as shown in Table 7.

Table 7   DB2_eWc e*Way Connection Parameters

8 Select Save from the File menu. Enter DB2_eWc as the file name and click Save.

9 Select Promote to Run Time from the File menu. Click OK to close the e*Way 
Connection configuration file editor.

10 Click OK to save the e*Way Connection’s properties.

5.4.6 Add the IQs
The sample scenario uses two IQs:

! Q1 – This IQ queues the inbound Events for the DBSelect e*Way.

! Q2 – This IQ queues the outbound Events for the FileOut e*Way.

To add the IQs

1 In the components pane of the Enterprise Manager, select the IQ Manager.

2 Click the New IQ button to add a new IQ.

3 Enter the name Q1 and click Apply to save the IQ and leave the New IQ dialog box 
open. 

4 Enter the name Q2 and click OK to save the second IQ.

5 Select the IQ Manager and click the Properties button.

6 Select the Start automatically check box and click OK to save the properties.

5.4.7 Add and Configure the Collaborations
The sample scenario uses three Collaborations:

! FileIn_PassThru – This Collaboration uses the GenericPassThru Collaboration 
Rule.

! DBSelect_collab – This Collaboration uses the GenericEventToDatabase 
Collaboration Rule to execute the dbCollab.class Java Collaboration file.

Section Name Parameter Value

DataSource class default

DatabaseName Use the database name 
listed in your ODBC entry.

user name Use local settings.

password Use local settings.

retry interval default

connector All default
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! FileOut_PassThru – This Collaboration uses the GenericPassThru Collaboration 
Rule.

To add the FileIn_PassThru Collaboration

1 In the components pane of the Enterprise Manager, select the FileIn e*Way.

2 Click the New Collaboration button to create a new Collaboration.

3 Enter the name FileIn_PassThru and click OK.

4 Select the newly created Collaboration and click the Properties button.

5 Select GenericPassThru from the dropdown list of Collaboration Rules.

6 Click the upper Add button to add a new Subscription.

7 Select the GenericEvent Event Type and the <External> source.

8 Click the lower Add button to add a new Publication.

9 Select the GenericEvent Event Type and the Q1 destination.

10 Click OK to close the Collaboration’s properties.

To add the DBselect_collab Collaboration

1 In the components pane of the Enterprise Manager, select the DBSelect e*Way.

2 Click the New Collaboration button to create a new Collaboration.

3 Enter the name DBselect_collab and click OK.

4 Select the newly created Collaboration and click the Properties button.

5 Select GenericEventToDatabase from the dropdown list of Collaboration Rules.

6 Click the upper Add button to add a new Subscription.

7 Select the GenericEvent Event Type and the FileIn_PassThru source.

8 Click the lower Add button to add a new Publication.

9 Select the DBEmployee Event Type and the DB2_eWc destination.

10 Click the lower Add button to add a new Publication.

11 Select the GenericEvent Event Type and the Q2 destination.

12 Click OK to close the Collaboration’s properties.

To add the FileOut_PassThru Collaboration

1 In the components pane of the Enterprise Manager, select the FileOut e*Way.

2 Click the New Collaboration button to create a new Collaboration.

3 Enter the name FileOut_PassThru and click OK.

4 Select the newly created Collaboration and click the Properties button.

5 Select GenericPassThru from the dropdown list of Collaboration Rules.

6 Click the upper Add button to add a new Subscription.

7 Select the GenericEvent Event Type and the DBSelect_collab source.
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8 Click the lower Add button to add a new Publication.

9 Select the GenericEvent Event Type and the <External> destination.

10 Click OK to close the Collaboration’s properties.

5.4.8 Run the Schema
Running the sample Schema requires that a sample input file be created. Once the input 
file has been created, you can start the Control Broker from a command prompt to 
execute the Schema. After the Schema has been run, you can view the output text file to 
verify the results.

The sample input file

Use a text editor to create an input file to be read by the inbound file e*Way (FileIn). 
This simple input file contains the criteria for the dbSelect.class Collaboration’s select 
statement. An example of an input file is shown in Figure 74.

Figure 74   Sample Input File

To start the Control Broker

From a command prompt, type the following command:

stccb -ln logical_name -rh registry -rs DBSelect -un user_name 
-up password

where

logical_name is the logical name of the Control Broker,

registry is the name of the Registry Host, and

user_name and password are a valid e*Gate username/password combination.

To verify the results

Use a text editor to view the output file c:\eGate\data\dbSelect_out\dbSelect0.dat. 
Figure 75 shows an example of the records that were returned by the sample schema.
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Figure 75   Sample Output File

5.4.9 Importing the OS/390 Sample Schema
To import the OS/390 sample schema included on the e*Gate Installation CD-ROM, do 
the following:

1 On the Enterprise Manager toolbar, click File, Import Definitions from File...

2 Review the information provided in the Import Wizard - Introduction window. 
Click Next.

3 On the Import Wizard - Step 1 window, select Schema and click Next.

4 On the Import Wizard - Step 2 window, browse to the ewdb2 sample folder.

5 Double click the ewdb2 sample folder and select the db2sample_OS390.zip file.

6 Click Open.

7 On the Import Wizard - Step 2 window, click Next.

8 On the Import Wizard - Step 3 window, you can rename the host or change the 
port. This step is optional.

9 Click Next.

10 On the Import Wizard - Finish window, click Finish.

11 Follow the instructions provided for the Polling Sample Schema to run your 
schema.
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DB2 e*Way Methods

The DB2 e*Way contains Java methods that are used to extend the functionality of the 
e*Way. These methods are contained in the following classes:

! com.stc.eways.jdbcx.StatementAgent Class on page 81

! com.stc.eways.jdbcx.PreparedStatementAgent Class on page 91

! com.stc.eways.jdbcx.PreparedStatementResultSet Class on page 103

! com.stc.eways.jdbcx.SqlStatementAgent Class on page 129

! com.stc.eways.jdbcx.CallableStatementAgent Class on page 131

! com.stc.eways.jdbcx.TableResultSet Class on page 143

6.1 com.stc.eways.jdbcx.StatementAgent Class
java.lang.Object
|
+ - - com.stc.eways.jdbcx.StatementAgent

All Implemented Interfaces

ResetEventListener, SessionEventListener

Direct Known Subclasses

PreparedStatementAgent, SQLStatementAgent, TableResultSet

public abstract class StatementAgent

extends java.lang.Object

Implements SessionEventListener, ResetEventListener

Abstract class for other Statement Agent.
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Methods of the StatementAgent

resultSetTypeToString

This method gets the symbol string corresponding to the ResultSet type enumeration.

public static java.lang.String resultSetTypeToString(int type)

Returns

Enumeration symbol string.

resultSetDirToString

This method gets the symbol string corresponding to the ResultSet direction 
enumeration.

public static java.lang.String resultSetDirToString(int dir)

cancel on page 89 clearBatch on page 89

clearWarnings on page 90 executeBatch on page 89

getFetchDirection on page 86 getFetchSize on page 87

getMaxFieldSize on page 88 getMaxRows on page 87

getMoreResults on page 89 getResultSet on page 88

getResultSetConcurrency on page 85 getResultSetType on page 84

getUpdateCount on page 88 getWarnings on page 90

isClosed on page 83 queryDescription on page 83

queryName on page 83 resetRequested on page 84

resultSetConcurToString on page 83 resultSetDirToString on page 82

resultSetTypeToString on page 82 sessionClosed on page 84

sessionOpen on page 84 setCursorName on page 85

setEscapeProcessing on page 85 setFetchDirection on page 86

setMaxFieldSize on page 88 setMaxRows on page 87

setQueryTimeout on page 86 setQueryTimeout on page 86

stmtInvoke on page 90

Name Description

type ResultSet type.

Name Description

dir ResultSet scroll directions.
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Returns

Enumeration symbol string.

resultSetConcurToString

This method gets the symbol string corresponding to the ResultSet concurrency 
enumeration.

public static java.lang.String resultSetConcurToString(int concur)

Returns

Enumeration symbol string.

isClosed

This method returns the statement agent’s close status.

public boolean isClosed()

Returns

True if the statement agent is closed.

queryName

This method supplies the name of the listener.

public java.lang.String queryName()

Specified By

queryName in interface SessionEventListener.

Returns

The listener’s class name.

queryDescription

This method gives a description of the query.

public java.lang.String queryDescription()

Returns

The description of the query.

Name Description

concur ResultSet concurrency.
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sessionOpen

Opens the session event handler.

public void sessionOpen(SessionEvent evt)

Specified by

sessionOpen in interface SessionEventListener

sessionClosed

Closes the session event handler.

public void sessionClosed(SessionEvent evt)

Specified by

sessionClosed in interface SessionEventListener

resetRequested

Resets the event handler.

public void resetRequested(ResetEvent evt)

Specified by

resetRequested in interface ResetEventListener

Throws

java.sql.SQLException

getResultSetType

Returns the result set scroll type.l

Name Description

evt Session event.

Name Description

evt Session event.

Name Description

evt Requested Reset event.
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public int getResultSetType()

Returns

ResultSet type

Throws

java.sql.SQLException

getResultSetConcurrency

Returns the result set concurrency mode.

public int getResultSetConcurrency()

Returns

ResultSet concurrency

Throws

java.sql.SQLException

setEscapeProcessing

Sets escape syntax processing

public void setEscapeProcessing (boolean bEscape)

Throws

java.sql.SQLException

setCursorName

Sets result set cursor name.

public void setCursorName(java.lang.String sName)

Throws

java.sql.SQLException

Name Description

bEscape True to enable
False to disable

Name Description

sName Cursor name.
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setQueryTimeout

Returns query timeout duration.

public int getQueryTimeout()

Returns

The number of seconds to wait before timeout.

Throws

java.sql.SQLException

setQueryTimeout

Sets the query timeout duration

public void setQueryTimeout(int nInterval)

Throws

java.sql.SQLException

getFetchDirection

Returns result set fetch direction.

public int getFetchDirection()

Returns

The fetch direction of the ResultSet: FETCH_FORWARD, FETCH_REVERSE, 
FETCH_UNKNOWN.

Throws

java.sql.SQLException

setFetchDirection

Sets result set fetch direction.

public void setFetchDirection (int iDir)

Name Description

nInterval The number of seconds before timeout.
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Throws

java.sql.SQLExeption

getFetchSize

Returns the result set prefetch record count.

public int getFetchSize()

Returns

The fetch size this StatementAgent object set.

Throws

java.sql.SQLException

getMaxRows

Returns the maximum number of fetch records.

public int getMaxRows()

Returns

The maximum number of rows that a ResultSetAgent may contain.

Throws

java.sql.SQLException

setMaxRows

Sets the maximum number of fetch records.

public void setMaxRows (int nRow)

Throws

java.sql.SQLException

Name Description

iDir The fetch direction of the ResultSet: 
FETCH_FORWARD, FETCH_REVERSE, 
FETCH_UNKNOWN.

Name Description

nRow The maximum number of rows in the 
ResultSetAgent.
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getMaxFieldSize

Returns the maximum field data size.

public int getMaxFieldSize()

Returns

The maximum number of bytes that a ResultSetAgent column may contain; 0 means no 
limit.

Throws

java.sql.SQLException

setMaxFieldSize

Sets the maximum field data size.

public void setMaxFieldSize (int nSize)

Throws

java.sql.SQLException

getUpdateCount

Returns the records count of the last executed statement.

public int getUpdateCount()

Returns

The number of rows affected by an updated operation. O if no rows were affected or 
the operation was a DDL command. -1 if the result is a ResultSetAgent or there are no 
more results.

Throws

java.sql.SQLException

getResultSet

Returns the result set of the last executed statement.

public ResultSetAgent getResultSet()

Returns

The ResultSetAgent that was produced by the call to the method execute.

Name Description

nSize The maximum size for a column in a 
ResultSetAgent.
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Throws

java.sql.SQLExcetpion

getMoreResults

Returns if there are more result sets.

public boolean getMoreResults()

Returns

True if the next result is a ResultSetAgent; False if it is an integer indicating an update 
count or there are no more results).

Throws

java.sql.SQLException

clearBatch

Clears the batch operation.

public void clearBatch()

Throws

java.sql.SQLException

executeBatch

Executes batch statements.

public int[] executeBatch ()

Returns

An array containing update counts that correspond to the commands that executed 
successfully. An update count of -2 means the command was successful but that the 
number of rows affected is unknown.

Throws

java.sql.SQLException

cancel

Cancels a statement that is being executed.

public void cancel()

Throws

java.sql.SQLException
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getWarnings

Returns SQL warning object.

public java.sql.SQLWarning getWarnings()

Returns

The first SQL warning or null if there are no warnings.

Throws

java.sql.SQLException

clearWarnings

Clear all SQL Warning objects.

public void clearWarnings()

Throws

java.sql.SQLException

stmtInvoke

Invokes a method of the database Statement object of this ETD.

public java.lang.Object stmtInvoke (java.lang.String methodName, 
java.lang.Class[] argsCls, java.lang.Object[] args)

Returns

The Object instance resulting from the method invocation. Can be null if nothing is 
returned (void return declaration).

Throws

java.lang.Exception. Whatever exception the invoked method throws.

Name Description

methodName The name of the method.

argsCls Class array for types of formal arguments 
for method, in the declared order. Can be 
null if there are no formal arguments. 
However, cannot invoke constructor here.

args Object array of formal arguments for 
method in the declared order. Can be null 
if there are no formal arguments. However, 
cannot invoke constructor here.
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6.2 com.stc.eways.jdbcx.PreparedStatementAgent Class
java.lang.Object

|

+ --com.stc.eways.jdbcx.StatementAgent

|

+ -- com.stc.eways.jdbcx.PreparedStatementAgent

All Implemented Interfaces

ResetEventListener, SessionEventListener

Direct Known Subclasses

CallableStatementAgent

public class PreparedStatementAgent

extends StatementAgent

Agent hosts PreparedStatement Object

Methods of the PreparedStatementAgent

sessionOpen

Opens the session event handler.

addBatch on page 102 clearParameters on page 102

execute on page 102 executeQuery on page 102

executeUpdate on page 102 sessionOpen on page 133

setArray on page 100 setAsciiStream on page 99

setBigDecimal on page 96 setBinaryStream on page 99

setBlob on page 101 setBoolean on page 94

setByte on page 94 setBytes on page 99

setCharacterStream on page 100 setClob on page 101

setDate on page 96 setDate on page 97

setDouble on page 96 setFloat on page 95

setInt on page 95 setLong on page 95

setNull on page 92 setObject on page 92

setObject on page 93 setObject on page 93

setRef on page 101 setShort on page 94

setString on page 98 setTime on page 97

setTime on page 97 setTimestamp on page 98

setTimestamp on page 98
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public void sessionOpen(SessionEvent evt)

Overrides

sessionOpen in class StatementAgent

setNull

Nullify value of indexed parameter.

public void setNull(int index, int type)

Throws

java.sql.SQLException

setNull

Nullify value of indexed parameter.

public void setNul(int index, int type, java.lang.String tname)

Throws

java.sql.SQLException

setObject

Sets value of indexed parameter with an object.

Name Description

evt Session event.

Name Description

index Parameter index starting from 1.

type A JDBC type defined by inava.sql.Types

Name Description

index Parameter index starting from 1.

type A JDBC type defined by inava.sql.Types

tname The fully-qualified name of the parameter 
being set. If type is not REF, STRUCT, 
DISTINCT, or JAVA_OBJECT, this parameter 
will be ignored.
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public void setObject(int index, java.lang.Object ob)

Throws

java.sql.SQLException

setObject

Sets value of indexed parameter with an object.

public void setObject(int index, java.lang.Object ob, int iType)

Throws

java.sql.SQLException

setObject

Sets value of indexed parameter with an object.

public void setObject(int index, java.lang.Object ob, int iType, int 
iScale)

Name Description

index Parameter index starting from 1.

ob An instance of a Java Object containing the 
input parameter value.

Name Description

index Parameter index starting from 1.

ob An instance of a Java Object containing the 
input parameter value.

iType A JDBC type defined by inava.sql.Types

Name Description

index Parameter index starting from 1.

ob An instance of a Java Object containing the 
input parameter value.

iType A JDBC type defined by inava.sql.Types

iScale The number of digits to the right of the 
decimal point. Only applied to DECIMAL 
and NUMERIC types
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Throws

java.sql.SQLException

setBoolean

Sets the boolean value of the indexed parameter.

public void setBoolean(int index, boolean b)

Throws

java.sql.SQLException

setByte

Sets the byte value of the indexed parameter.

public void setByte(int index, byte byt)

Throws

java.sql.SQLException

setShort

Sets the short value of the indexed parameter.

public void setShort(int index, short si)

Throws

java.sql.SQLException

Name Description

index Parameter index starting from 1.

b true or false.

Name Description

index Parameter index starting from 1.

byt The byte parameter value to be set.

Name Description

index Parameter index starting from 1.

si The short parameter value to be set.
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setInt

Sets the integer value of the indexed parameter.

public void setInt(int index, int i)

Throws

java.sql.SQLException

setLong

Sets the long value of the indexed parameter.

public void setLong(int index, long l)

Throws

java.sql.SQLException

setFloat

Sets the float value of the indexed parameter.

public void setFloat(int index, float f)

Throws

java.sql.SQLException

Name Description

index Parameter index starting from 1.

i The integer parameter value to be set.

Name Description

index Parameter index starting from 1.

l The long parameter value to be set.

Name Description

index Parameter index starting from 1.

f The float parameter value to be set.
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setDouble

Sets the double value of the indexed parameter.

public void setDouble(int index, double d)

Throws

java.sql.SQLException

setBigDecimal

Sets the decimal value of the indexed parameter.

public void setBigDecimal(int index, java.math.BigDecimal dec)

Throws

java.sql.SQLException

setDate

Sets the date value of the indexed parameter.

public void setDate(int index, java.sql.Date date)

Throws

java.sql.SQLException

Name Description

index Parameter index starting from 1.

d The double parameter value to be set.

Name Description

index Parameter index starting from 1.

dec The BigDecimal parameter value to be set.

Name Description

index Parameter index starting from 1.

date The Date parameter value to be set.
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setDate

Sets the date value of indexed parameter with time zone from calendar.

public void setDate(int index, java.sql.Date date, java.util.Calendar 
cal)

Throws

java.sql.SQLException

setTime

Sets the time value of the indexed parameter.

public void setTime(int index, java.sql.Time t)

Throws

java.sql.SQLException

setTime

Sets the time value of the indexed parameter.

public void setTime(int index, java.sql.Time t, java.util.Calendar 
cal)

Name Description

index Parameter index starting from 1.

date The Date parameter value to be set.

cal The calender object used to construct the 
date.

Name Description

index Parameter index starting from 1.

t The Time parameter value to be set.

Name Description

index Parameter index starting from 1.

t The Time parameter value to be set.

cal The Calendar object used to construct the 
time.
e*Way Intelligent Adapter for
DB2 Universal Database User’s Guide 97 SeeBeyond Proprietary and Confidential



Chapter 6 Section 6.2
DB2 e*Way Methods com.stc.eways.jdbcx.PreparedStatementAgent Class
Throws

java.sql.SQLException

setTimestamp

Sets the timestamp value of the indexed parameter.

public void setTimestamp(int index, java.sql.Timestamp ts)

Throws

java.sql.SQLException

setTimestamp

Sets the timestamp value of the indexed parameter with the time zone from the 
calendar.

public void setTimestamp(int index, java.sql.timestamp ts, 
java.util.Calendar cal)

Throws

java.sql.SQLException

setString

Sets the string value of the indexed parameter.

public void setString(int index, java.lang.String s)

Name Description

index Parameter index starting from 1.

ts The Timestamp parameter value to be set.

Name Description

index Parameter index starting from 1.

ts The Timestamp parameter value to be set.

cal The Calendar object used to construct the 
timestamp.

Name Description

index Parameter index starting from 1.
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Throws

java.sql.SQLException

setBytes

Sets the byte array value of the indexed parameter.

public void setBytes(int index, byte[] bytes)

Throws

java.sql.SQLException

setAsciiStream

Sets the character value of the indexed parameter with an input stream and specified 
length.

public void setAsciiStream(int index, java.io.InputStream is, int 
length)

Throws

java.sql.SQLException

setBinaryStream

Sets the binary value of the indexed parameter with an input stream and specified 
length.

s The String parameter value to be set.

Name Description

index Parameter index starting from 1.

bytes The byte array parameter value to be set.

Name Description

index Parameter index starting from 1.

is The InputStream that contains the Ascii 
parameter value to be set.

length The number of bytes to be read from the 
stream and sent to the database.

Name Description
e*Way Intelligent Adapter for
DB2 Universal Database User’s Guide 99 SeeBeyond Proprietary and Confidential



Chapter 6 Section 6.2
DB2 e*Way Methods com.stc.eways.jdbcx.PreparedStatementAgent Class
public void setBinaryStream(int index, java.io.InputStream is, int 
length)

Throws

java.sql.SQLException

setCharacterStream

Sets the character value of the indexed parameter with a reader stream and specified 
length.

public void setCharacterStream(int index, java.io.Reader rd, int 
length)

Throws

java.sql.SQLException

setArray

Sets the Array value of the indexed parameter.

public void setArray(int index, java.sql.Array a)

Name Description

index Parameter index starting from 1.

is The InputStream that contains the binary 
parameter value to be set.

length The number of bytes to be read from the 
stream and sent to the database.

Name Description

index Parameter index starting from 1.

rd The Reader that contains the Unicode 
parameter value to be set.

length The number of characters to be read from 
the stream and sent to the database.

Name Description

index Parameter index starting from 1.

a The Array value to be set.
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Throws

java.sql.SQLException

setBlob

Sets the Blob value of the indexed parameter.

public void setBlob(int index, java.sql.Blob blob)

Throws

java.sql.SQLException

setClob

Sets the Clob value of the indexed parameter.

public void setClob(int index, java.sql.Clob clob)

Throws

java.sql.SQLException

setRef

Sets the Ref value of the indexed parameter.

public void setRef(int index, java.sql.Ref ref)

Throws

java.sql.SQLException

Name Description

index Parameter index starting from 1.

blob The Blob value to be set.

Name Description

index Parameter index starting from 1.

clob The Clob value to be set.

Name Description

index Parameter index starting from 1.

ref The Ref parameter value to be set.
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clearParameters

Clears the parameters of all values.

public void clearParameters()

Throws

java.sql.SQLException

addBatch

Adds a set of parameters to the list of commands to be sent as a batch.

public void addBatch()

Throws

java.sql.SQLException

execute

Executes the Prepared SQL statement.

public void execute()

Throws

java.sql.SQLException

executeQuery

Executes the prepared SQL query and returns a ResultSetAgent that contains the 
generated result set.

public ResultSetAgent executeQuery()

Returns

ResultSetAgent or null.

Throws

java.sql.SQLException

executeUpdate

Executes the prepared SQL statement and returns the number of rows that were 
affected.

public int executeUpdate()

Returns

The number of rows affected by the update operation; 0 if no rows were affected. 
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Throws

java.sql.SQLException

6.3 com.stc.eways.jdbcx.PreparedStatementResultSet 
Class

java.lang.Object

|

+ -- com.stc.eways.jdbcx.PreparedStatementResultSet

public abstract class PreparedStatementResultSet

extends java.lang.Object

Base class for Result Set returned from a Prepared Statement execution.

Constructors of PreparedStatementResultSet

PreparedStatementResultSet
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Methods of PreparedStatementResultSet

absolute on page 107 afterLast on page 109

beforeFirst on page 109 clearWarnings on page 127

close on page 107 deleteRow on page 128

findColumn on page 110 first on page 108

getArray on page 124 getArray on page 124

getAsciiStream on page 123 getAsciiStream on page 123

getBigDecimal on page 116 getBigDecimal on page 117

getBinaryStream on page 123 getBinaryStream on page 124

getBlob on page 125 getBlob on page 125

getBoolean on page 112 getBoolean on page 112

getByte on page 113 getByte on page 113

getBytes on page 122 getBytes on page 122

getCharacterStream on page 124 getCharacterStream on page 124

getClob on page 125 getClob on page 126

getConcurrency on page 105 getCursorName on page 107

getDate on page 117 getDate on page 117

getDate on page 118 getDate on page 118

getDouble on page 116 getDouble on page 116

getFetchDirection on page 105 getFetchSize on page 106

getFloat on page 115 getFloat on page 116

getInt on page 114 getInt on page 114

getLong on page 114 getLong on page 115

getMetaData on page 105 getObject on page 110

getObject on page 111 getObject on page 111

getObject on page 112 getRef on page 126

getRef on page 127 getRow on page 128

getShort on page 113 getShort on page 113

getString on page 121 getString on page 121

getTime on page 118 getTime on page 118

getTime on page 119 getTime on page 119

getTimestamp on page 120 getTimestamp on page 120

getTimestamp on page 120 getTimestamp on page 121

getType on page 110 getWarnings on page 127

insertRow on page 128 isAfterLast on page 110

isBeforeFirst on page 109 isFirst on page 108
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Constructor PreparedStatementResultSet

Constructs a Prepared Statement Result Set object.

public PreparedStatementResultSet(ResultSetAgent rsAgent)

getMetaData

Retrieves a ResultSetMetaData object that contains ResultSet properties.

public java.sql.ResultSetMetaData getMetaData()

Returns

ResultSetMetaData object

Throws

java.sql.SQLException

getConcurrency

Gets the concurrency mode for this ResultSet object.

public int getConcurrency()

Returns

Concurrency mode

Throws

java.sql.SQLException

getFetchDirection

Gets the direction suggested to the driver as the row fetch direction.

public int getFetchDirection()

isLast on page 109 last on page 108

next on page 107 previous on page 107

refreshRow on page 149 relative on page 108

getFetchDirection on page 105 getFetchSize on page 106

updateRow on page 128 wasNull on page 127

Name Description

rsAgent The ResultSetAgent underlying control.
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Returns

Row fetch direction

Throws

java.sql.SQLException

setFetchDirection

Gives the driver a hint as to the row process direction.

public void setFetchDirection(int iDir)

Throws

java.sql.SQLException

getFetchSize

Gets the number of rows to fetch suggested to the driver.

public int getFetchSize()

Returns

Number of rows to fetch at a time.

Throws

java.sql.SQLException

setFetchSize

Gives the drivers a hint as to the number of rows that should be fetched each time.

public void setFetchSize(int nSize)

Throws

java.sql.SQLException

Name Description

iDir Fetch direction to use.

Name Description

nSize Number of rows to fetch at a time.
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getCursorName

Retrieves the name for the cursor associated with this ResultSet object.

public java.lang.String getCursorName()

Returns

Name of cursor

Throws

java.sql.SQLException

close

Immediately releases a ResultSet object’s resources.

public void close()

Throws

java.sql.SQLException

next

Moves the cursor to the next row of the result set.

public boolean next()

Returns

true if successful

Throws

java.sql.SQLException

previous

Moves the cursor to the previous row of the result set.

public boolean previous()

Returns

true if successful

Throws

java.sql.SQLException

absolute

Moves the cursor to the specified row of the result set.

public boolean absolute(int index)
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Returns

true if successful

Throws

java.sql.SQLException

relative

Moves the cursor to the specified row relative to the current row of the result set.

public boolean relative(int index)

Returns

true if successful

Throws

java.sql.SQLException

first

Moves the cursor to the first row of the result set.

public boolean first()

Returns

true if successful

Throws

java.sql.SQLException

isFirst

Determines whether the cursor is on the first row of the result set.

public boolean isFirst()

Returns

true if on the first row.

Throws

java.sql.SQLException

last

Moves the cursor to the last row of the result set.

public boolean last()
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Returns

true if successful

Throws

java.sql.SQLException

isLast

Determines whether the cursor is on the last row of the result set.

public boolean isLast()

Returns

true if on the last row

Throws

java.sql.SQLException

beforeFirst

Moves the cursor before the first row of the result set.

public void beforeFirst()

Throws

java.sql.SQLException

isBeforeFirst

Determines whether the cursor is before the first row of the result set.

public boolean isBeforeFirst()

Returns

true if before the first row

Throws

java.sql.SQLException

afterLast

Moves the cursor after the last row of the result set.

public void afterLast()

Throws

java.sql.SQLException
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isAfterLast

Determines whether the cursor is after the last row of the result set.

public boolean isAfterLast()

Returns

true if after the last row

Throws

java.sql.SQLException

getType

Retrieves the scroll type of cursor associated with the result set.

public int getType()

Returns

Scroll type of cursor.

Throws

java.sql.SQLException

findColumn

Returns the column index for the named column in the result set.

public int findColumn(java.lang.String index)

Returns

Corresponding column index.

Throws

java.sql.SQLException

getObject

Gets the object value of the specified column.

public java.lang.Object getObject(int index)

Name Description

index Column name.
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Returns

Object form of column value.

Throws

java.sql.SQLException

getObject

Gets the object value of the specified column.

public java.lang.Object getObject(java.lang.String index)

Returns

Object form of column value.

Throws

java.sql.SQLException

getObject

Gets the object value of the specified column using the given type map.

public java.lang.Object getObject(int index, java.util.Map.map)

Returns

Object form of column value.

Throws

java.sql.SQLException

Name Description

index Column index.

Name Description

index Column index.

Name Description

index Column index.

map Type map.
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getObject

Gets the object value of the specified column using the given type map.

public java.lang.Object getObject(java.lang.String index, 
java.util.Map map)

Returns

Object form of column value.

Throws

java.sql.SQLException

getBoolean

Gets the boolean value of the specified column.

public boolean getBoolean(int index)

Returns

Boolean value of the column.

Throws

java.sql.SQLException

getBoolean

Gets the boolean value of the specified column.

public boolean getBoolean(java.lang.String index))

Returns

Boolean value of the column.

Name Description

index Column index.

map Type map.

Name Description

index Column index.

Name Description

index Column name.
e*Way Intelligent Adapter for
DB2 Universal Database User’s Guide 112 SeeBeyond Proprietary and Confidential



Chapter 6 Section 6.3
DB2 e*Way Methods com.stc.eways.jdbcx.PreparedStatementResultSet Class
Throws

java.sql.SQLException

getByte

Gets the byte value of the specified column.

public byte getByte(int index)

Returns

Boolean value of the column.

Throws

java.sql.SQLException

getShort

Gets the short value of the specified column.

public short getShort(int index)

Returns

Short value of the column.

Throws

java.sql.SQLException

getShort

Gets the short value of the specified column.

public short getShort(java.lang.String index)

Name Description

index Column index.

Name Description

index Column index.

Name Description

index Column name.
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Returns

Short value of the column.

Throws

java.sql.SQLException

getInt

Gets the integer value of the specified column.

public int getInt(int index)

Returns

Int value of the column.

Throws

java.sql.SQLException

getInt

Gets the integer value of the specified column.

public int getInt(java.lang.String index)

Returns

Int value of the column.

Throws

java.sql.SQLException

getLong

Gets the long value of the specified column.

public long getLong(int index)

Name Description

index Column index.

Name Description

index Column name.
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Returns

Long value of the column.

Throws

java.sql.SQLException

getLong

Gets the long value of the specified column.

public long getLong(java.lang.String index)

Returns

Long value of the column.

Throws

java.sql.SQLException

getFloat

Gets the float value of the specified column.

public float getFloat(int index)

Returns

Float value of the column.

Throws

java.sql.SQLException

Name Description

index Column index.

Name Description

index Column name.

Name Description

index Column index.
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getFloat

Gets the float value of the specified column.

public float getFloat(java.lang.String index)

Returns

Float value of the column.

Throws

java.sql.SQLException

getDouble

Gets the double value of the specified column.

public double getDouble(int index)

Returns

Double value of the column.

Throws

java.sql.SQLException

getBigDecimal

Gets the decimal value of the specified column.

public java.math.BigDecimal getBigDecimal(int index)

Returns

Big decimal value of the column.

Name Description

index Column name.

Name Description

index Column index.

Name Description

index Column index.
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Throws

java.sql.SQLException

getBigDecimal

Gets the decimal value of the specified column.

public java.math.BigDecimal getBigDecimal(java.lang.String index)

Returns

Big decimal value of the column.

Throws

java.sql.SQLException

getDate

Gets the date value of the specified column.

public java.sql.Date getDate(int index)

Returns

Date value of the column.

Throws

java.sql.SQLException

getDate

Gets the date value of the specified column.

public java.sql.Date getDate(java.lang.String index)

Name Description

index Column name.

Name Description

index Column index.

Name Description

index Column name.
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Returns

Date value of the column.

Throws

java.sql.SQLException

getDate

Gets the date value of the specified column using the time zone from the calendar.

public java.sql.Date getDate(java.lang.String index, 
java.util.Calendar calendar)

Returns

Date value of the column.

Throws

java.sql.SQLException

getTime

Gets the time value of the specified column.

public java.sql.Time getTime(int index)

Returns

Time value of the column.

Throws

java.sql.SQLException

getTime

Gets the time value of the specified column.

public java.sql.Time getTime(java.lang.String index)

Name Description

index Column name.

calendar Calendar to use.

Name Description

index Column index.
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Returns

Time value of the column.

Throws

java.sql.SQLException

getTime

Gets the time value of the specified column.

public java.sql.Time getTime(int index, java.util.Calendar calendar)

Returns

Time value of the column.

Throws

java.sql.SQLException

getTime

Gets the time value of the specified column.

public java.sql.Time getTime(java.lang.String index, 
java.util.Calendar calendar)

Returns

Time value of the column.

Throws

java.sql.SQLException

Name Description

index Column name.

Name Description

index Column index.

calendar Calendar to use.

Name Description

index Column name.

calendar Calendar to use.
e*Way Intelligent Adapter for
DB2 Universal Database User’s Guide 119 SeeBeyond Proprietary and Confidential



Chapter 6 Section 6.3
DB2 e*Way Methods com.stc.eways.jdbcx.PreparedStatementResultSet Class
getTimestamp

Gets the timestamp value of the specified column.

public java.sql.Timestamp getTimestamp(int index)

Returns

The timestamp value of the column.

Throws

java.sql.SQLException

getTimestamp

Gets the timestamp value of the specified column.

public java.sql.Timestamp getTimestamp(java.lang.String index)

Returns

The timestamp value of the column.

Throws

java.sql.SQLException

getTimestamp

Gets the timestamp value of the specified column using the time zone from the 
calendar.

public java.sql.Timestamp getTimestamp(int index, java.util.Calendar 
calendar)

Returns

The timestamp value of the column.

Name Description

index Column index.

Name Description

index Column name.

Name Description

index Column index.
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Throws

java.sql.SQLException

getTimestamp

Gets the timestamp value of the specified column using the time zone from the 
calendar.

public java.sql.Timestamp getTimestamp(java.lang.String index, 
java.util.Calendar calendar)

Returns

The timestamp value of the column.

Throws

java.sql.SQLException

getString

Gets the string value of the specified column.

public java.lang.String getString(int index)

Returns

Returns the String value of the column.

Throws

java.sql.SQLException

getString

Gets the string value of the specified column.

public java.lang.String getString(java.lang.String index)

Name Description

index Column name.

calendar Calendar to use.

Name Description

index Column index.
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Returns

Returns the String value of the column.

Throws

java.sql.SQLException

getBytes

Gets the byte array value of the specified column.

public byte[] getBytes(int index)

Returns

Byte array value of the column.

Throws

java.sql.SQLException

getBytes

Gets the byte array value of the specified column.

public byte[] getBytes(java.lang.String index)

Returns

Byte array value of the column.

Throws

java.sql.SQLException

Name Description

index Column name.

Name Description

index Column index.

Name Description

index Column name.
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getAsciiStream

Retrieves the value of the specified column value as a stream of ASCII characters.

public java.io.InputStream getAsciiStream(int index)

Returns

ASCII output stream value of the column.

Throws

java.sql.SQLException

getAsciiStream

Retrieves the value of the specified column value as a stream of ASCII characters.

public java.io.InputStream getAsciiStream(java.lang.String index)

Returns

ASCII output stream value of the column.

Throws

java.sql.SQLException

getBinaryStream

Retrieves the value of the specified column as a stream of uninterpreted bytes.

public java.io.InputStream getBinaryStream(int index)

Returns

Binary out steam value of the column.

Name Description

index Column index.

Name Description

index Column name.

Name Description

index Column index.
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Throws

java.sql.SQLException

getBinaryStream

Retrieves the value of the specified column as a stream of uninterpreted bytes.

public java.io.InputStream getBinaryStream(java.lang.String index)

Returns

Binary out steam value of the column.

Throws

java.sql.SQLException

getCharacterStream

Retrieves the value of the specified column as a Reader object.

public java.io.Reader getCharacterStream(int index)

Returns

Reader for value in the column.

Throws

java.sql.SQLException

getArray

Gets the Array value of the specified column.

public java.sql.Array getArray(int index)

Name Description

index Column name.

Name Description

index Column index.

Name Description

index Column index.
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Returns

Array value of the column.

Throws

java.sql.SQLException

getBlob

Gets the Blob value of the specified column.

public java.sql.Blob getBlob(int index)

Returns

Blob value of the column.

Throws

java.sql.SQLException

getBlob

Gets the Blob value of the specified column.

public java.sql.Blob getBlob(java.lang.String index)

Returns

Blob value of the column.

Throws

java.sql.SQLException

getClob

Gets the Clob value of the specified column.

public java.sql.Clob getClob(int index)

Name Description

index Column index.

Name Description

index Column name.
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Returns

Clob value of the column.

Throws

java.sql.SQLException

getClob

Gets the Clob value of the specified column.

public java.sql.Clob getClob(java.lang.String index)

Returns

Clob value of the column.

Throws

java.sql.SQLException

getRef

Gets the Ref value of the specified column.

public java.sql.Ref getRef(int index)

Returns

Ref value of the column.

Throws

java.sql.SQLException

Name Description

index Column index.

Name Description

index Column name.

Name Description

index Column index.
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getRef

Gets the Ref value of the specified column.

public java.sql.Ref getRef(java.lang.String index)

Returns

Ref value of the column.

Throws

java.sql.SQLException

wasNull

Checks to see if the last value read was SQL NULL or not.

public boolean wasNull()

Returns

true if SQL NULL.

Throws

java.sql.SQLException

getWarnings

Gets the first SQL Warning that has been reported for this object.

public java.sql.SQLWarning getWarnings()

Returns

SQL warning.

Throws

java.sql.SQLException

clearWarnings

Clears any warnings reported on this object.

public void clearWarnings()

Throws

java.sql.SQLException

Name Description

index Column name.
e*Way Intelligent Adapter for
DB2 Universal Database User’s Guide 127 SeeBeyond Proprietary and Confidential



Chapter 6 Section 6.3
DB2 e*Way Methods com.stc.eways.jdbcx.PreparedStatementResultSet Class
getRow

Retrieves the current row number in the result set.

public int getRow()

Returns

Current row number

Throws

java.sql.SQLException

refreshRow

Replaces the values int the current row of the result set with their current values in the 
database.

public void refreshRow()

Throws

java.sql.SQLException

insertRow

Inserts the contents of the insert row into the result set and the database.

public void insertRow()

Throws

java.sql.SQLException

updateRow

Updates the underlying database with the new contents of the current row.

public void updateRow()

Throws

java.sql.SQLException

deleteRow

Deletes the current row from the result set and the underlying database.

public void deleteRow()

Throws

java.sql.SQLException
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6.4 com.stc.eways.jdbcx.SqlStatementAgent Class
java.lang.Object

|

+ -- com.stc.eways.jdbcx.StatementAgent

|

+ -- com.stc.eways.jdbcx.SqlStatementAgent

All Implemented Interfaces

ResetEventListener, SessionEventListener

public class SqlStatementAgent

extends StatementAgent

SQLStatement Agent that hosts a managed Statement object.

Constructors of the SqlStatementAgent

SqlStatementAgent

SqlStatementAgent

Methods of the SqlStatementAgent

Constructor SqlStatementAgent

Creates new SQLStatementAgent with scroll direction TYPE_FORWARD_ONLY and 
concurrency CONCUR_READ_ONLY.

public SqlStatementAgent(Session session)

Constructor SqlStatementAgent

Creates a new SQLStatementAgent.

public SqlStatementAgent(Session session, int iScroll, int iConcur)

addBatch on page 131 execute on page 130

executeQuery on page 130 executeUpdate on page 131

Name Description

session Connection session.
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execute

Executes the specified SQL statement.

public boolean execute(java.lang.String sSql)

Returns

true if the first result is a ResultSetAgent or false if it is an integer.

Throws

java.sql.SQLException

executeQuery

Executes the specified SQL query and returns a ResultSetAgent that contains the 
generated result set.

public ResultSetAgent executeQuery(java.lang.String sSql)

Returns

A ResultSetAgent or null

Throws

java.sql.SQLException

Name Description

session Connection session.

iScroll Scroll direction: TYPE_FORWARD_ONLY, 
TYPE_SCROLL_INSENSITIVE, 
TYPE_SCROLL_SENSITIVE.

iConcur Concurrency: CONCUR_READ_ONLY, 
CONCUR_UPDATABLE.

Name Description

sSql SQL statement.

Name Description

sSql SQL statement.
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executeUpdate

Executes the specified SQL statement and returns the number of rows that were 
affected.

public int executeUpdate(jave.lang.String sSql)

Returns

The number of rows affected by the update operation; 0 if no rows were affected. 

Throws

java.sql.SQLException

addBatch

Adds the specified SQL statement to the list of commands to be sent as a batch.

public void addBatch(java.lang.String sSql)

Throws

java.sql.SQLException

6.5 com.stc.eways.jdbcx.CallableStatementAgent Class
java.lang.Object

|

+ -- com.stc.eways.jdbcx.StatementAgent

|

+ -- com.stc.eways.jdbcx.PreparedStatementAgent

|

+ -- com.stc.eways.jdbcx.CallableStatementAgent

All Implemented Interfaces

ResetEventListener, SessionEventListener

Name Description

sSql SQL statement.

Name Description

sSql SQL statement.
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Direct Known Subclasses

StoredProcedureAgent

public abstract class CallableStatementAgent

extends PreparedStatementAgent

Agent hosts CallableStatement interface

Constructors of the CallableStatementAgent

CallableStatementAgent

CallableStatementAgent

CallableStatementAgent

Methods of the CallableStatementAgent

Constructor CallableStatementAgent

Creates new CallableStatementAgent with scroll direction TYPE_FORWARD_ONLY 
and concurrency CONCUR_READ_ONLY.

public CallableStatementAgent(Session session, java.lang.String 
sCommand)

getArray on page 141 getBigDecimal on page 138

getBlob on page 142 getBoolean on page 136

getByte on page 136 getBytes on page 141

getClob on page 142 getDate on page 138

getDate on page 139 getDouble on page 138

getFloat on page 137 getInt on page 137

getLong on page 137 getObject on page 135

getObject on page 135 getRef on page 143

getShort on page 136 getString on page 141

getTime on page 139 getTimestamp on page 140

getTimestamp on page 140 registerOutParameter on page 134

registerOutParameter on page 134 registerOutParameter on page 134

sessionOpen on page 133 wasNull on page 135

Name Description

session Connection session.

sCommand The Call statement used to invoke a stored 
procedure.
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Constructor CallableStatementAgent

Creates a new CallableStatementAgent.

public CallableStatementAgent(Session session, int iScroll, int 
iConcur)

Constructor CallableStatement Agent

Creates a new CallableStatementAgent.

public CallableStatementAgent(Session session, java.lang.String 
sCommand, int iScroll, int iConcur)

sessionOpen

Opens the session event handler.

public void sessionOpen(SessionEvent evt)

Overrides

sessionOpen in class PreparedStatementAgent

Name Description

session Connection session.

iScroll Ignored.

iConcur Ignored

Name Description

session Connection session.

sCommand The Call statement used to invoke a stored 
procedure.

iScroll Scroll direction: TYPE_FORWARD_ONLY, 
TYPE SCROLL_INSENSITIVE, 
TYPE_SCROLL_SENSITIVE

iConcur Concurrency: CONCUR_READ_ONLY, 
CONCUR_UPDATEABLE

Name Description

evt Session event.
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registerOutParameter

Registers the indexed OUT parameter with specified type.

public void registerOutParameter(int index, int iType)

Throws

java.sql.SQLException

registerOutParameter

Registers the indexed OUT parameter with specified type and scale.

public void registerOutParameter(int index, int iType, int iScale)

Throws

java.sql.SQLException

registerOutParameter

Registers the indexed OUT parameter with specified user-named type or REF type.

public void registerOutParameter(int index, int iType, 
java.lang.String sType)

Name Description

index Parameter index starting from 1.

iType A JDBC type defined by inava.sql.Types.

Name Description

index Parameter index starting from 1.

iType A JDBC type defined by inava.sql.Types.

iScale The number of digits to the right of the 
decimal point. Only applied to DECIMAL 
and NUMERIC types.

Name Description

index Parameter index starting from 1.

iType A JDBC type defined by inava.sql.Types.

tName The fully-qualified name of the parameter 
being set. It is intended to be used by REF, 
STRUCT, DISTINCT, or JAVA_OBJECT.
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Throws

java.sql.SQLException

wasNull

Returns whether or not the last OUT parameter read had the SQL NULL value.

public boolean wasNull()

Returns

true if the parameter read is SQL NULL; otherwise, false

Throws

java.sql.SQLException

getObject

Gets the value of the indexed parameter as an instance of Object.

public java.lang.Object getObject(int index)

Returns

The Object value

Throws

java.sql.SQLException

getObject

Gets the value of the indexed parameter as an instance of Object and uses map for the 
customer mapping of the parameter value.

public java.lang.Object getObject(int index, java.util.Map map)

Name Description

index Parameter index starting from 1.

Name Description

index Parameter index starting from 1.

map A Map object for mapping from SQL type 
names for user-defined types to classes in 
the Java programming language.
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Returns

An Object value

Throws

java.sql.SQLException

getBoolean

Gets the boolean value of the indexed parameter.

public boolean getBoolean(int index)

Returns

A boolean value

Throws

java.sql.SQLException

getByte

Gets byte value of the indexed parameter.

public byte getByte(int index)

Returns

A byte value

Throws

java.sql.SQLException

getShort

Gets short value of the indexed parameter.

public short getShort(int index)

Returns

A short value

Name Description

index Parameter index starting from 1.

Name Description

index Parameter index starting from 1.
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Throws

java.sql.SQLException

getInt

Gets integer value of the indexed parameter.

public int getInt(int index)

Returns

A int value

Throws

java.sql.SQLException

getLong

Gets long value of the indexed parameter.

public long getLong(int index)

Returns

A long value

Throws

java.sql.SQLException

getFloat

Gets float value of the indexed parameter.

public float getFloat(int index)

Name Description

index Parameter index starting from 1.

Name Description

index Parameter index starting from 1.

Name Description

index Parameter index starting from 1.
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Returns

A float value

Throws

java.sql.SQLException

getDouble

Gets double value of the indexed parameter.

public double getDouble(int index)

Returns

A float value

Throws

java.sql.SQLException

getBigDecimal

Gets decimal value of the indexed parameter.

public java.math.BigDecimal getBigDecimal(int index)

Returns

A BigDecimal object

Throws

java.sql.SQLException

getDate

Gets date value of the indexed parameter.

public java.sql.Date getDate(int index)

Name Description

index Parameter index starting from 1.

Name Description

index Parameter index starting from 1.
e*Way Intelligent Adapter for
DB2 Universal Database User’s Guide 138 SeeBeyond Proprietary and Confidential



Chapter 6 Section 6.5
DB2 e*Way Methods com.stc.eways.jdbcx.CallableStatementAgent Class
Returns

A Date object

Throws

java.sql.SQLException

getDate

Gets date value of the indexed parameter with time zone from calendar.

public java.sql.Date getDate(int index, java.util.Calendar calendar)

Returns

A Date object

Throws

java.sql.SQLException

getTime

Gets time value of the indexed parameter.

public java.sql.Time getTime(int index)

Returns

A Time object

Throws

java.sql.SQLException

Name Description

index Parameter index starting from 1.

Name Description

index Parameter index starting from 1.

cal The Calendar object used to construct the 
timestamp.

Name Description

index Parameter index starting from 1.
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getTime

Gets time value of the indexed parameter with time zone from calendar.

public java.sql.Time getTime(int index, java.util.Calendar calendar)

Returns

A Time object

Throws

java.sql.SQLException

getTimestamp

Gets timestamp value of the indexed parameter.

public java.sql.timestamp getTimestamp(int index)

Returns

A Timestamp object

Throws

java.sql.SQLException

getTimestamp

Gets timestamp value of the indexed parameter.

public java.sql.timestamp getTimestamp(int index, java.util.Calendar 
calendar)

Name Description

index Parameter index starting from 1.

cal The Calendar object used to construct the 
timestamp.

Name Description

index Parameter index starting from 1.

Name Description

index Parameter index starting from 1.

cal The Calendar object used to construct the 
timestamp.
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Returns

A Timestamp object

Throws

java.sql.SQLException

getString

Gets string value of the indexed parameter.

public java.lang.String getString(int index)

Returns

A String object

Throws

java.sql.SQLException

getBytes

Gets byte array value of the indexed parameter.

public byte[] getBytes(int index)

Returns

An array of bytes

Throws

java.sql.SQLException

getArray

Gets Array value of the indexed parameter.

public java.sql.Array getArray(int index)

Name Description

index Parameter index starting from 1.

Name Description

index Parameter index starting from 1.
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Returns

An Array object

Throws

java.sql.SQLException

getBlob

Gets Blob value of the indexed parameter.

public java.sql.Blob getBlob(int index)

Returns

A Blob object

Throws

java.sql.SQLException

getClob

Gets Clob value of the indexed parameter.

public java.sql.Clob getClob(int index)

Returns

A Blob object

Throws

java.sql.SQLException

Name Description

index Parameter index starting from 1.

Name Description

index Parameter index starting from 1.

Name Description

index Parameter index starting from 1.
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getRef

Gets Ref value of the indexed parameter.

public java.sql.Ref getRef(int index)

Returns

A Ref object

Throws

java.sql.SQLException

6.6 com.stc.eways.jdbcx.TableResultSet Class
java.lang.Object

|

+ -- com.stc.eways.jdbcx.StatementAgent

|

+ -- com.stc.eways.jdbcx.TableResultSet

All Implemented Interfaces

ResetEventListener, SessionEventListener

public abstract class TableResultSet

extends StatementAgent

ResultSet to map selected records of table in the database

Methods of the TableResultSet

Name Description

index Parameter index starting from 1.

absolute on page 145 afterLast on page 147

beforeFirst on page 146 cancelRowUpdates on page 150

deleteRow on page 149 findColumn on page 147

first on page 145 getAsciiStream on page 148

getAsciiStream on page 148 getBinaryStream on page 148

getBinaryStream on page 148 getCharacterStream on page 148

getCharacterStream on page 149 insertRow on page 149

isAfterLast on page 147 isBeforeFirst on page 147
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select

Select table records.

public void select(java.lang.String sWhere)

Throws

java.sql.SQLException

next

Navigate one row forward.

public boolean next()

Returns

true if the move to the next row is successful; otherwise, false.

Throws

java.sql.SQLException

previous

Navigate one row backward. It should be called only on ResultSetAgent objects that are 
TYPE_SCROLL_SENSITIVE or TYPE_SCROLL_INSENSITIVE.

public boolean previous()

Returns

true if the cursor successfully moves to the previous row; otherwise, false.

Throws

java.sql.SQLException

isFirst on page 146 isLast on page 146

last on page 146 moveToCurrentRow on page 150

moveToInsertRow on page 149 next on page 144

previous on page 144 relative on page 145

rowDeleted on page 150 rowInserted on page 150

rowUpdated on page 150 select on page 144

updateRow on page 149 wasNull on page 151

Name Description

sWhere Where condition for the query.
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absolute

Move cursor to specified row number. It should be called only on ResultSetAgent 
objects that are TYPE_SCROLL_SENSITIVE or TYPE_SCROLL_INSENSITIVE.

Returns

true if the cursor successfully moves to the specified row; otherwise, false.

Throws

java.sql.SQLException

relative

Move the cursor forward or backward a specified number of rows. It should be called 
only on ResultSetAgent objects that are TYPE_SCROLL_SENSITIVE or 
TYPE_SCROLL_INSENSITIVE.

public boolean relative(int rows)

Returns

true if the cursor successfully moves to the number of rows specified; otherwise, false.

Throws

java.sql.SQLException

first

Move the cursor to the first row of the result set. It should be called only on 
ResultSetAgent objects that are TYPE_SCROLL_SENSITIVE or 
TYPE_SCROLL_INSENSITIVE.

public boolean first()

Returns

true if the cursor successfully moves to the first row; otherwise, false.

Name Description

row An integer other than 0.

Name Description

rows The number of rows to move the cursor, 
starting at the current row. If the rows are 
positive, the cursor moves forward; if the 
rows are negative, the cursor moves 
backwards.
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Throws

java.sql.SQLException

isFirst

Check if the cursor is on the first row. It should be called only on ResultSetAgent 
objects that are TYPE_SCROLL_SENSITIVE or TYPE_SCROLL_INSENSITIVE.

public boolean isFirst()

Returns

true if the cursor successfully moves to the first row; otherwise, false.

Throws

java.sql.SQLException

last

Move to the last row of the result set. It should be called only on ResultSetAgent objects 
that are TYPE_SCROLL_SENSITIVE or TYPE_SCROLL_INSENSITIVE.

public boolean last()

Returns

true if the cursor successfully moves to the last row; otherwise, false.

Throws

java.sql.SQLException

isLast

Check if the cursor is positioned on the last row. It should be called only on 
ResultSetAgent objects that are TYPE_SCROLL_SENSITIVE or 
TYPE_SCROLL_INSENSITIVE.

public boolean isLast()

Returns

true if the cursor is on the last row; otherwise, false

Throws

java.sql.SQLException

beforeFirst

Move the cursor before the first row. It should be called only on ResultSetAgent objects 
that are TYPE_SCROLL_SENSITIVE or TYPE_SCROLL_INSENSITIVE.

public void beforeFirst()
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Throws

java.sql.SQLException

isBeforeFirst

Check if the cursor is positioned before the first row. It should be called only on 
ResultSetAgent objects that are TYPE_SCROLL_SENSITIVE or 
TYPE_SCROLL_INSENSITIVE.

public boolean isBeforeFirst()

Returns

true if the cursor successfully moves before the first row; otherwise, false

Throws

java.sql.SQLException

afterLast

Move the cursor after the last row.It should be called only on ResultSetAgent objects 
that are TYPE_SCROLL_SENSITIVE or TYPE_SCROLL_INSENSITIVE.

public void afterLast()

Throws

java.sql.SQLException

isAfterLast

Returns true if the cursor is positioned after the last row. It should be called only on 
ResultSetAgent objects that are TYPE_SCROLL_SENSITIVE or 
TYPE_SCROLL_INSENSITIVE.

public boolean isAfterLast()

Returns true if the cursor successfully moves after the last row; otherwise, false.

Throws

java.sql.SQLException

findColumn

Finds the index of the named column.

public int findColumn(java.lang.String index)

Throws

java.sql.SQLException
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getAsciiStream

Returns the column data as an AsciiStream.

public java.io.InputStream getAsciiStream(int index)

Throws

java.sql.SQLException

getAsciiStream

Returns the column data as an AsciiStream.

public java.io.InputStream getAsciiStream(java.lang.String 
columnName)

Throws

java.sql.SQLException

getBinaryStream

Returns the column data as BinaryStream.

public java.io.InputStream getBinaryStream(int index)

Throws

java.sql.SQLException

getBinaryStream

Returns the column data as BinaryStream.

public java.io.InputStream getBinaryStream(java.lang.String 
columnName)

Throws

java.sql.SQLException

getCharacterStream

Returns the column data as CharacterStream.

public java.io.Reader getCharacterStream(int index)

Throws

java.sql.SQLException
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getCharacterStream

Returns the column data as CharacterStream.

public java.io.Reader getCharacterStream(java.lang.String columnName)

Throws

java.sql.SQLException

refreshRow

Refreshes the current row with its most recent value from the database.

public void refreshRow()

Throws

java.sql.SQLException

insertRow

Inserts the contents of the current row into the database.

public void insertRow()

Throws

java.sql.SQLException

updateRow

Updates the contents of the current row into the database.

public void updateRow()

Throws

java.sql.SQLException

deleteRow

Deletes the contents of the current row from the database.

public void deleteRow()

Throws

java.sql.SQLException

moveToInsertRow

Moves the current position to a new insert row.

public void moveToInsertRow()
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Throws

java.sql.SQLException

moveToCurrentRow

Moves the current position to the current row. It is used after you insert a row.

public void moveToCurrentRow()

Throws

java.sql.SQLException

cancelRowUpdates

Cancels any updates made to this row.

public void cancelRowUpdates()

Throws

java.sql.SQLException

rowInserted

Returns true if the current row has been inserted.

public boolean rowInserted()

Throws

java.sql.SQLException

rowUpdated

Returns true i the current row has been updated.

public boolean rowUpdated()

Throws

java.sql.SQLException

rowDeleted

Returns true if the current row has been deleted.

public boolean rowDeleted()

Throws

java.sql.SQLException
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wasNull

Returns true if the last data retrieved is NULL.

public boolean wasNull()

Throws

java.sql.SQLException
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Appendix A

Appendix

A.1 ADO/ODBC Calls
These calls are made by the DBWizard for metadata discovery.

A.1.1 ADO Calls

A.1.2 ODBC Calls

OpenSchema(adSchemaTables Retrieves the list of tables.

OpenSchema(adSchemaColumns) Retrieves the column information for a 
table.

OpenSchema(adSchemaProcedures) Retrieves the list of stored procedures.

OpenSchema(adSchemaProcedureParameters) Retrieves the parameter information of a 
stored procedure.

SQLDataSources Retrieves the list of DSNs.

SQLPrepared Used to prepare a SQL prepared statement 
string.

SQLNumParams Retrieves the number of parameters in a 
prepared statement.

SQLDescribeParam Retrieves information about a prepared 
statement parameter.

SQLNumResultCols Retrieves the number of resultset columns in 
a prepared statement.

SQLDescribeCol Retrieves information about a resultset 
column in a prepared statement.
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